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Chapter 1: About the User Guide
Welcome to the ShadowProtect User Guide. This Guide describes the ShadowProtect technology,
how to use the product, and how to derive maximum benefit from ShadowProtect. ShadowProtect
comes in three editions. While most differences between the various editions of ShadowProtect relate
to the associated user license, this Guide specifically identifies information that applies to a specific
edition.
Table 1: Shadow Protect editions

Edition

Description

ShadowProtect
Desktop Edition

Provides volume backup and restore options for a single system. This edition is
most suitable for home use.

ShadowProtect
Server Edition

Provides backup and restore options for multiple desktop and server systems.

ShadowProtect
Provides backup and restore options for multiple desktop and server systems in a
SBS Edition
small business environment.
(Small Business)

This Guide includes the following general sections:
Chapter 2: ShadowProtect Overview

7

Chapter 3: How ShadowProtect Works
Chapter 4: Installing ShadowProtect

13

18

Chapter 5: Understanding ShadowProtect Console
Chapter 6: Creating Backup Image Files
Chapter 7: Mounting Backup Image Files
Chapter 8: Restoring a Volume

54

Chapter 9: Backup Image Tool

57

Chapter 10: Remote Management
Chapter 11: Using VirtualBoot

67

Chapter 12: Other Operations

76

Chapter 13: Best Practices

25

38
49

60

83

Additionally, this Guide includes the following general information sections.
Chapter 14: Common Retention Policy Configurations
Chapter 15: Product Support
Chapter 16: Glossary

85

86

Chapter 17: Technician License Agreement
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Additional Information
For emerging issues and other resources, see the following:
The readme.txt file included on the ShadowProtect CD.
The StorageCraft technical support Web site at www.storagecraft.com/support.html
This User Guide is also available in the ShadowProtect user interface from the Help menu.
For a glossary of ShadowProtect terms and definitions, see Chapter 16: Glossary

86

.

Documentation Conventions
This symbol designates Note or Warning text that provides important information about the
configuration and/or use of ShadowProtect.
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Chapter 2: ShadowProtect Overview
ShadowProtect provides robust and flexible disaster recovery by creating and managing backup image
files. Each backup image file represents the exact state of your system at a given point-in-time.
ShadowProtect provides tremendous advantages over traditional disaster recovery methods.
Table 2: Restoring a system volum e

Other Methods

ShadowProtect

1

Repair hardware if necessary

1

Repair hardware if necessary

2

Collect all necessary OS media

2

Boot from Recovery CD

3

Reload OS from CD-ROM

3

Restore entire system or selected files

4

Reboot

4

Reboot

5

Apply multiple service packs

6

Reboot (this could take several reboots)

7

Reload backup software from CD-ROM

8

Patch backup software to the latest support
level

9

Reboot

10

Load recovery tape and restore

FULLY RESTORED IN MINUTES

FULLY RESTORED IN HOURS
You should be aware of the following information as you prepare to install and use ShadowProtect:
Features and Components
Usage Scenarios

10

Backup Image Files

15
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Features and Components
ShadowProtect consists of the following primary components:
Table 3: Shadow Protect com ponents

Component

Features
A Windows-based disaster recovery environment that provides the following primary
features:
New! VirtualBoot lets you create a VM from any backup image file that you can
then boot in the VirtualBox Virtual Machine environment.
New! The Backup Image tool now provides the ability to convert backup image
files into virtual file formats, including the VMWare VMDK format and the Microsoft
VHD format.
New! Support for Windows 7 and Windows Server 2008 R2, including 64-bit
support.
New! The Management View greatly simplifies the administration of
ShadowProtect on multiple systems, including the ability to push the
ShadowProtect Backup agent out to remote systems.
Microsoft Volume Shadow Copy Service (VSS) aware.
Schedule live backups in the background while you work.

ShadowProtect
Console

Backup to any accessible drive, including network storage (SAN, NAS, iSCSI),
removable drives (USB, FireWire), and optical media (CD, DVD, Blu-Ray).
Verify backup images to ensure complete recovery.
An easy-to-use user interface that lets you quickly recover folders or files from a
backup image.
Create compressed and encrypted backup image files for efficiency and security.
Mount backup images for simple folder or file updates.
Restore your system to an exact point-in-time.
Restore images to different hardware or to virtual environments (P2P,P2V,V2P).
View backup images for quick file and folder recovery.
Shrink Volume allows you to shrink an image file so you can restore to a smaller
drive.
I/O throttling for each backup job.
Remotely manage system backup and recovery operations.

StorageCraft
Recovery
Environment

The ShadowProtect CD contains a bootable Windows environment for disaster
recovery options without installing any software. For more information about the
Recovery Environment, see the StorageCraft Recovery Environment User Guide.
New! Resume on Interrupt lets you resume an interrupted restore operation from
the point of interruption, rather than having to start the restore process over
again.

© 2010 StorageCraft Technology Corporation
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New! An improved Boot Configuration Tool with support for Windows 7.
New! HeadStart Restore lets you restore a volume while ShadowProtect
continues to add Incremental backup images to the same backup image chain.
This can reduce restore time from days or weeks to minutes or hours, even for
very large volumes.
Access all the features of the ShadowProtect Console from a standalone
disaster recovery environment.
Loads from the bootable ShadowProtect CD.
Create ExactState™ backup images without installing any software.
If the system is unable to boot, ShadowProtect lets you back up the system
before a destructive restore potentially destroys valuable data
Use Hardware Independent Restore (HIR) to restore backup image files to a
different environment, either physical or virtual.
Network configuration tool to manage TCP/IP properties, domains and network
resources.
Remotely recover your system and data
Perform a quick and simple bare metal system recovery.

ShadowProtect
Backup Agent

The engine that creates and manages a system's point-in-time backup images.
The Backup Agent also handles mounting of backup image files. You can manage
the operation of the Backup Agent from the ShadowProtect Console.
To access the ShadowProtect Backup Agent, you must be a domain user with local
administration rights.
ImageManager provides unprecedented control over your backup image files. It
provides policy-driven services for managing backup image files, including:
Consolidation of Incremental backup image files into daily, weekly, and monthly
consolidated image files that greatly reduce the number of files in an image
chain.
Verification and re-verification of backup image files, including consolidated
files.
Replication of backup image files to a local drive.

ImageManager

New! For an additional fee you can extend replication support to off-site storage
through LAN/WAN and FTP.
New! For an additional fee, Head Start Restore (HSR) provides the ability to
restore a backup image while ShadowProtect continues to add Incremental
backup images to the same backup image chain. In a world of multi-Terabyte
storage HSR lets you short-circuit the restore process, greatly limiting the downtime associated with hardware failure or migration tasks.
For more information about ImageManager features, see the ShadowProtect

ImageManager User Guide.

© 2010 StorageCraft Technology Corporation
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Usage Scenarios
ShadowProtect offers a variety of backup and recovery solutions, depending on your needs. This
section includes several usage scenarios that help describe ShadowProtect features and benefits.
ShadowProtect usage scenarios are organized into the following types:
ShadowProtect Console Scenarios
VirtualBoot Scenarios

10

11

ShadowProtect Console Scenarios
The following scenarios introduce several common use cases for ShadowProtect:

Live Backup
Problem: When taking system backups, I cannot take the time to shutdown a system each
time I want to create a backup image.
ShadowProtect Solution: By leveraging disk imaging with existing Windows snapshot
technology, ShadowProtect lets you create live system backups without any system downtime.
ShadowProtect creates live backup images that include a system's operating system, critical
data and configuration settings.

ExactState Backup Images
Problem: I need to create the most reliable and recoverable backup images possible.
ShadowProtect Solution: ShadowProtect includes ExactState backup image technology that
lets you create an image from the StorageCraft Recovery Environment, thereby ensuring that all
system files and resources are closed and in a state where ShadowProtect can create a
complete backup image. ExactState image technology supports all Windows server and
desktop operating systems.

Create Full and Incremental Backup Images
Problem: Making a full backup image every time I backup a system is very time consuming. I
need to be able to make incremental backup images to save time and space.
ShadowProtect Solution: ShadowProtect uses a sector-based backup strategy that lets it
backup just the changes to a file in an Incremental backup image file. Sector-based incremental
backup is the quickest and most efficient way to take an incremental backup. Once you have an
initial Full backup, you can create regular Incremental backup images from that point forward.

Individual Folder and File Restore
Problem: Restoring individual files and folders traditional backup systems, such as a tape drive,
can be very difficult and time-consuming...assuming I can even find the necessary data in the
first place. I need a quick and easy method to recover lost files or folders.
ShadowProtect Solution: Use the ShadowProtect Backup Explore Wizard to mount a backup
image file as a volume using a Drive letter or mount point. Once mounted, you can explore and
recover individual files and folders from the backup image. Disk-based backup images provide
fast file access, and you can even share backup images so Since the backups are disk-based,
the process is very fast and easy and uses Windows Explorer. The IT administrator can mount a
backup image and share this with end users who can select the files and folders they need to
© 2010 StorageCraft Technology Corporation
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restore.

Update an Existing Backup Image
Problem: I have an existing backup image, but need to update a driver in that image, or clean a
virus or other malware from the backup image before restoring files. I don't want to have to clean
the system, then re-create the backup image before using it to restore a system.
ShadowProtect Solution: Because you can mount ShadowProtect backup image files as
read/write volumes, you can modify and repair backup images as needed. ShadowProtect saves
backup image changes as a separate Incremental image file.

VirtualBoot Scenarios
The following scenarios introduce several possible use cases for VirtualBoot:

Historical Data Access
Problem: After transitioning to a new financial management system, you are audited. To satisfy the
audit, you need access to historical tax records stored in the proprietary format of the old financial
software. Unfortunately, you no longer have the old software, so you cannot access your historical
tax records.
VirtualBoot Solution: Rather than trying to restore a complete backup image that contains the old
financial software, use VirtualBoot to boot the backup image, which gives you access to both the
application and the data from your system at the time of the backup. By preserving the applications
with the data, you can greatly extend the lifespan of your data.

Software Testing
Problem: You need to find out how some new software performs on your production system, but
you don't want to risk having any problems.
VirtualBoot Solution: VirtualBoot the latest backup of your production system, then install the
software in the virtual machine. You can evaluate the software performance using your system's
actual production environment without any risk to your production system.

Backup Image Testing
Problem: You need to confirm that your backup images restore properly and that they provide
access to all your mission critical applications and data.
VirtualBoot Solution: VirtualBoot a recent backup image and you can verify that the restored
applications and data perform as expected..

Hardware Failure
Problem: You have a database server and the 20TB disk array crashes. You need to get the
system back on-line and replace the disk subsystem.
VirtualBoot Solution: VirtualBoot the latest backup image of your database server and continue to
create incremental backups within the VM (the incremental backups are part of the original backup
image chain). As soon as the VM is available, users can continue to use the database server as if
the database server is still on-line. The interim VM solution performs well because there is no file
conversion required. StorageCraft provides native support for its backup image files in the VirtualBox
© 2010 StorageCraft Technology Corporation
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environment.
Once the VM is up and running, start a Head Start Restore (HSR) on the database server's new disk
subsystem (For information about HSR, see the ShadowProtect ImageManager User Guide). Once
HSR catches up to the most current incremental, you can finalize the HSR installation on the new
disk subsystem, take the VM down, then bring the database server back on-line. VirtualBoot
reduces downtime from several days to only minutes.
Note: Once you have the replacement VM environment running, and continuing the incremental
backup image chain, you have to ability to recover the system several different ways, including:
restore to the original hardware, repaired as necessary; restore to new hardware (using HIR); or
restore permanently to a VM environment. Whatever you choose, VirtualBoot helps eliminate
the downtime associated with the failure.

© 2010 StorageCraft Technology Corporation
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Chapter 3: How ShadowProtect Works
ShadowProtect provides robust and flexible disaster recovery by creating and managing backup image
files. Each backup image file represents the exact state of your system at a given point-in-time.

Shadow Protect Backup and Restore - How it Works

There are two primary tasks related to data recovery with ShadowProtect:
Create a Backup Image

14

Restore a Backup Image

© 2010 StorageCraft Technology Corporation
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Create a Backup Image
Creating a ShadowProtect backup image involves two key processes:

Create a Virtual Volume
Using Microsoft VolSnap and VSS (with Windows Server 2003, Windows XP, or later), ShadowProtect
creates a point-in-time snapshot of the volume you want to backup. The entire process of taking a
snapshot of a volume and creating a virtual volume takes only seconds and does not interfere with
system operation.
Table 4: Snapshot m ethods supported by Shadow Protect

Snapshot

Supported OS

Image
Speed

Quality

Comments
VSS aware applications are managed to
achieve best backups.

StorageCraft
VSM with VSS

Windows Server
2000 Family

Fast

Best

Can use script files to manage
applications that are not VSS aware to
improve backups.
VSS aware applications are managed
automatically to achieve best backups.

Microsoft
VolSnap with
VSS

Windows Server
2003/2008 Family

Slow

Best

Use script files (before and after the
snapshot) to manage non-VSS-aware
applications and improve backups.
Cannot create Incremental Image File
(see Chapter 16: Glossary 86 ).

StorageCraft
VSM direct

Windows 2000
Server Family
Windows
2003/2008 Server
Family

Fast

Good

Use script files (before and after the
snapshot) to manage applications (both
VSS and non-VSS) and improve
backups.

Additionally, ShadowProtect provides a Backup Scheduler that lets you configure automated backup
jobs for protected volumes. You can schedule Full Image, Incremental Images (as often as every 15
minutes), and manage the retention of backup Image Sets. The ShadowProtect Backup Image Tool
simplifies image management by letting you manage existing image files, including consolidating files
in an Image Set, modifying password encryption and compression, and merging or splitting image
files.

Capture the Virtual Volume
To backup the volume, ShadowProtect replicates the virtual volume to create a backup image file. A
back up image file is a sector-by-sector representation of the volume at the time the volume snapshot
was taken. For more information about backup image files, see Backup Image Files 15 .
ShadowProtect writes the backup image file to the designated storage media. Options include network
storage (SAN, iSCSI, NAS, etc.), removable storage (USB / FireWire), and optical storage (CD, DVD,
Blu-ray). The amount of time it takes to write the backup image file depends upon the system
hardware and the size of the image file. For information about configuring and creating backup image
files, see Chapter 6: Creating Backup Image Files 38 .
© 2010 StorageCraft Technology Corporation
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Restore a Backup Image
Once you have created a backup image, you can use a ShadowProtect backup image to restore data
in two different ways:

Recover individual files and folders
Use the ShadowProtect Mount utility to mount the backup image file as a volume using either a drive
letter or a mount point. The Mount utility can efficiently mount hundreds of backup images
simultaneously, if desired. Furthermore, since the mounted backup image files preserve the Windows
volume properties, users can share and access the backup image file for emergency access to
backup image file data, including modifying and saving changes to the backup image file as an
incremental backup file.
For more information about mounting backup image files to recover data, see Chapter 7: Mounting
Backup Image Files 49 .

Restore an entire volume
Use the ShadowProtect Restore Wizard to restore an entire volume from a backup image file. You can
restore system volumes (that contains the system's operating system) using the StorageCraft
Recovery Environment, or restore non-system volumes using either Recovery Environment or while
running ShadowProtect Console in Windows. For more information about recovering volumes, see
Chapter 8: Restoring Backup Image Files 54 .

3.3

Backup Image Files
A ShadowProtect backup image file is a point-in-time representation of a computer volume. It is not a
standard file copy of the volume, but rather a sector-by-sector duplicate of the volume. Because of
this, you can mount a backup image file (using the ShadowProtect Mount utility) and view its contents
as if it were a regular volume. In the event that you need to recover data, you can recover specific files
and folders from the image or you may recover the entire volume to the exact point-in-time that the
backup image was taken.
ShadowProtect uses the following types of backup image files to provide a complete disaster recovery
solution.
Table 5: Types of backup im age files

Backup Images

Full (.spf)

Incremental (.spi)

© 2010 StorageCraft Technology Corporation

Description
A stand-alone image file that represents a disk volume at a specific
point-in-time. Full backup image files do not rely and does not rely on
any other files.
An image file that contains volume changes relative to another backup
image file. You can create Incremental backup image files relative to
Full backup images or other Incremental backup images.
ShadowProtect also creates an Incremental image file when an
existing image file is mounted as a read/write volume and modified.
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Incremental backup image files let ShadowProtect offer multiple
volume backup strategies, including Differential and Incremental
backup options. See Chapter 16: Glossary 86 for information about
these backup strategies.

Spanned (.sp#)

Image files that belong to a spanned Image Set. Spanned Image Sets
are made by breaking a backup image file into pieces for increased
portability (for example, to save the image file on multiple CDs).
The actual Spanned image file name replaces the pound sign (#) with
a number that indicates the position of the file within the spanned
Image Set.

ImageManager
(-cd.spi, -cw.spi,
-cm.spi)

Image files that have been automatically collapsed by ShadowProtect
ImageManager. The suffix before the file extension indicates if the file is
a daily, weekly or monthly collapsed backup files.

.spk

A password key file used to encrypt backup image files.

File Naming Conventions
ShadowProtect backup image files use the following naming convention to help you identify the file and
its relationship to, and dependencies on, other backup image files.
<Volume Identifier>-b<base-seq>-d<diff-seq>-i<inc-seq>.<extension>
volume identifier: Identifies the volume that the backup image file represents.
base-seq: The Base Image File sequence number. This either identifies the sequence number of
this file, or identifies the Base Image File upon which this file is dependent.
diff-seq: The Differential backup sequence number. This either identifies the sequence number of
this file, or identifies the Differential Image File upon which this file is dependent.
inc-seq: The Incremental backup sequence number. This either identifies the sequence number of
this file, or identifies the Incremental Image File upon which this file is dependent.
extension: The file extension, which identifies if the file is a Full, Incremental, or Spanned backup
image file.
Table 6: Exam ples of backup im age file nam es

File Type Extension

Description

C_Vol-b001.spf

Full image of the C:\ volume.

C_Vol-b001-d001-i000.spi

Differential image of the C:\ volume with a dependency on
the full backup image file C_Vol-b001.spf

*
or
C_Vol-b001.d001.spi

© 2010 StorageCraft Technology Corporation
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Incremental image of the C:\ volume with a dependency on
the full backup image file C_Vol-b001.spf

or
C_Vol-b001-i001.spi

C_Vol-b001-d001.i001.spi

Incremental backup image file of the C:\ volume with a
dependency on the differential backup image file C_Volb001-d001.i000 which in turn has a dependency on
C_Vol-b001.spi.

Note: Backup image file names that have a “-d000” or “-i000” segment use these name
segments only as place holders, and indicate that a differential backup image or an
incremental backup image are not part of the image and the backup image file has no
dependency on a previous differential or incremental backup image file.

File Dependencies
By examining the name of a backup image file, ShadowProtect users can identify the files on which it
depends. However, it is not possible to determine if other backup image files are dependent on this
file. Because of this, it is very important to use the Backup Image Tool (see Chapter 9: Backup Image
Tool 57 ) to review dependencies prior to moving, modifying or deleting backup images.

Warning: Deleting a backup image file on which other files depend renders the
dependent backup image files useless. You cannot browse or restore files
contained by these dependent backup image files.

Note: Deleting a full image file from an active backup image job causes ShadowProtect to
create a new Full image during the next scheduled backup and start a new backup Image
Set.

© 2010 StorageCraft Technology Corporation
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Chapter 4: Installing ShadowProtect
Before installing ShadowProtect, review the Requirements

18

and the License and Install Options

20

.

To Install ShadowProtect
1.

Insert the ShadowProtect CD into the system's CD drive.
If the installation does not start automatically, browse the ShadowProtect CD and run
AUTORUN from the root of the CD.

2.

On the Product Installation CD home page, select the product version to install (Desktop,
Server, Small Business Server).
The appropriate install Wizard loads to walk you through the installation process.

3.

On the Welcome page, click Next.

4.

On the License Agreement page, select I accept the terms of the license agreement, then
click Next.
You must accept the license agreement to install ShadowProtect. Click Print to print out the
License Agreement.

6.

On the Choose Components page, select the ShadowProtect components to install, then click
Next.
Agent: Installs the ShadowProtect Backup agent, which lets you remotely manage
ShadowProtect operations on this system.
Console: Installs the ShadowProtect Management View, which lets you manage
ShadowProtect operations for the system, and remote systems if desired..
Mount: Installs the ShadowProtect mount driver and adds the ability to mount and dismount a
backup image file using the right-click menu in Windows Explorer.

7.

In the Ready to Install the Program page, click Install.

8.

In the InstallShield Wizard Complete page, select Yes, I want to restart my computer now,
then click Finish.
If you cannot restart the computer immediately, select No, I will restart my computer later.
However, you must restart the computer before attempting to use ShadowProtect.

9.

4.1

Remove the ShadowProtect CD from the system's CD drive.

Requirements
ShadowProtect has the following hardware and software requirements:
Hardware Requirements

19

Supported Operating Systems
Supported File Systems

19

20

Supported Storage Media

20
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Hardware Requirements
Table 7: Shadow Protect hardw are requirem ents

Hardware

ShadowProtect Console

Recovery Environment

CPU

300 MHz or higher Pentium compatible
CPU

300 MHz or higher Pentium compatible
CPU

The greater of 128 MB or the Operating
System minimum

Windows XP: 256 MB minimum

Memory

Hard Drive space

10 MB free disk space

N/A

CD-ROM or DVD
drive

Required

Required

Windows Vista: 512 MB minimum

Supported Operating Systems
Specific Operating System support is dependent upon the edition of ShadowProtect that you have
purchased. However, ShadowProtect supports both 32-bit and 64-bit versions of the operating system,
where applicable.
Table 8: Shadow Protect operating system requirem ents

Edition

Description
Windows XP Family, including:

ShadowProtect
Desktop Edition

XP Home
XP Professional
Windows Vista Family, including:
Vista Home Basic
Vista Home Premium
Vista Business
Vista Ultimate
Windows 7
Windows 2000 Server Family (Cold Backup only through the StorageCraft
Recovery Environment. For more information, see the StorageCraft Recovery
Environment User Guide.

ShadowProtect
Server Edition

2000 Server
2000 Advanced Server
2000 Datacenter Server
Small Business Server 2000
Windows Server 2003 Family, including:
Server 2003 Standard Edition
Server 2003 Standard Edition R2
Server 2003 Advanced Edition
Server 2003 Advanced Edition R2

© 2010 StorageCraft Technology Corporation
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Server 2003 Enterprise Edition
Server 2003 Enterprise Edition R2
Server 2003 Datacenter Edition
Server 2003 Datacenter Edition R2
Server 2003 Web Edition
Small Business Server 2003
Windows Server 2008 (including R2)
ShadowProtect
SBS Edition
(Small Business)

Small Business Server 2003
Small Business Server 2008

Supported File Systems
ShadowProtect supports the following File Systems:
FAT16
FAT16X
FAT32
FAT32X
NTFS
Dynamic Disks

Supported Storage Media
ShadowProtect supports the following storage media:
Locally-connected hard drives
Removeable hard drives (USB or FireWire)
Network drives (SAN, NAS, iSCSI)
Optical media (CD, DVD, Blu-Ray)

4.2

License and Install Options
Use of ShadowProtect is governed by the ShadowProtect End User License Agreement (see Chapter
17: End User License Agreement 90 ). However, StorageCraft provides the following ShadowProtect
license options to help you in your decision-making process:
Purchased License: StorageCraft licenses ShadowProtect on a per system basis (based on the
number of systems for which you are making backups. For example, using ShadowProtect to
backup 100 computers requires 100 licenses. Before using the Software, review the complete End
User License Agreement .
Evaluation Version License: StorageCraft provides an Evaluation version of the ShadowProtect
Software as a CD or ISO image file. With the Evaluation version, you can create backup image files
of system and data volumes. You can also restore system and data volumes or specific files and
© 2010 StorageCraft Technology Corporation
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folders. The Evaluation version includes the StorageCraft Recovery Environment, so you can restore
system volumes with the Evaluation version. The Evaluation version expires and ceases to operate
when the Evaluation period ends. Images created during the Evaluation period are fully compatible
with the registered (purchased) version of the Software.
Trial Version License: StorageCraft provides a Trial version of the ShadowProtect software as a
free download. With the Trial version, you can create backup image files of system and data
volumes. You can also restore system and data volumes or specific files and folders. However, the
Trial version expires and ceases to operate when the trial period ends. Images created during the
trial period are fully compatible with the registered (purchased) version of ShadowProtect. However,
you cannot restore the system volumes because StorageCraft Recovery Environment is not included
with the Trial version.

4.3

Starting ShadowProtect
You can access ShadowProtect in two ways:
From Windows: Select Start > All Programs > ShadowProtect > ShadowProtect.
From Recovery Environment: Put the ShadowProtect CD in the system's CD-ROM drive, then
boot the system. Make sure your system boot sequence is set to boot from the CD before the hard
drive. For more information about loading and using Recovery Environment, see the Recovery
Environment User Guide.

4.4

Activating ShadowProtect
When you purchase ShadowProtect, StorageCraft provides you with a product serial number and an
Evaluation version of the purchased product. The Evaluation version provides 30 days of product
access, during which you must activate the product. If you do not activate the product within 30 days
of installation, the product times out and stops functioning.
You can activate ShadowProtect in the following ways:
Automatic Activation
Manual Activation
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You can also deactivate a previously activated ShadowProtect installation to free a product license for
use by another system (see Deactivating ShadowProtect 23 ).

Automatic Activation
StorageCraft provides an activation server that you can use to quickly and easily activate your
ShadowProtect installation.
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To activate ShadowProtect automatically
1.

Start ShadowProtect.
For more information, see Starting ShadowProtect

21

.

2.

From the Menu Bar select Help > Product Activation.

3.

In the Product Activation dialog box, provide the requested information, then click OK.
Customer Name: (Optional) Specify the name of the product purchaser, either person or
organization.
Product Serial Number: Enter the serial number that you received when purchasing
ShadowProtect.

4.

ShadowProtect notifies you if the activation process was successful.
a. If the activation is successful, click Close.
b. If the activation was not successful, review the message to determine why the activation
was unsuccessful. To correct the problem, do one of the following:
i.

Review the information in the Product Activation dialog box for accuracy. Correct
any errors, then OK to resubmit the activation request.

ii.

If your computer cannot successfully communicate to the activation server or the
Internet, wait for a while and try the activation process again.. You can also try
using a manual activation option.

iii. If the number of allowed activations for the serial number has been exceeded, you
must purchase additional licenses. If you feel you received this message in error,
contact StorageCraft Support (see Chapter 15: Product Support 85 .)
iv. For all other activation issues, contact StorageCraft Support (see Chapter 15:
Product Support 85 .)
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Manual Activation
If for some reason you are unable to use the automated activation method, StorageCraft provide the
following manual options for activating your ShadowProtect installation. These manual options require
you to receive the activation key and manually apply it to your ShadowProtect installation.
To get an activation key
1.

Use one of the following methods to contact StorageCraft and request an activation key.
Online: Open a Web browser to http://www.storagecraft.com/product_activation.php.
Email: Request an activation key from StorageCraft Support (support@storagecraft.com).
Phone: Call StorageCraft Support (see Chapter 15: Product Support

2.

85

).

Provide the information required to generate an activation key.
Product Serial Number: Enter the serial number that you received when purchasing
ShadowProtect.
Machine ID: ShadowProtect generates the Machine ID during the installation process. You
can view the Machine ID in the ShadowProtect Activation dialog box (select Help > Product
Activation).
Version: The ShadowProtect version you installed. You can view this by selecting Help >
About.
Language: The product language you are using (English, Japanese, French, or German).

3.

When you receive the activation key, continue with To activate ShadowProtect manually.
Depending on the method used to request the activation key, StorageCraft will deliver it to you
either in a Web form or via an Email where you can copy and paste it into your ShadowProtect
installation.

To activate ShadowProtect manually
1.

Start ShadowProtect.
For more information, see Starting ShadowProtect
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.

2.

From the Menu Bar select Tools > Product Activation.

3.

In the Activation dialog box, select Manual activation.

4.

In the Activation Key field, type or copy the activation key, then click Activate.

Deactivating ShadowProtect
When retiring a system, you can deactivate the ShadowProtect license to make the license available
for use on another system.
To deactivate a ShadowProtect license
1.

Start ShadowProtect.
For more information, see Starting ShadowProtect

2.

21

From the Menu Bar select Help > Product Activation.
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3.

Click Deactivate.
ShadowProtect displays a message stating you can no longer use this product key on this
machine

4.

4.5

Click OK.

Uninstalling ShadowProtect
Use the standard Windows application removal tool to uninstall ShadowProtect.
To uninstall ShadowProtect
1. In Windows, select Start > Settings > Control Panel > Add or Remove Programs.
2. Select ShadowProtect 4.x, then click Remove.
3. Click Yes to complete the uninstall.
After uninstalling ShadowProtect, you must reboot the computer for the changes to take
effect.
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Chapter 5: Understanding ShadowProtect Console
ShadowProtect Console provides access to most configuration and operation controls for
ShadowProtect:

Shadow Protect Console

The console is divided into three panels:
Navigation Panel: Located on the left side of the console, the Navigation panel provides access to
the tasks and tools necessary to configure and operate ShadowProtect. For more information, see
Navigation Panel 27 .
Main Panel: Located in the center of the console, the Main panel contains tabbed views of
ShadowProtect tasks and information. For more information, see Tabs 29 .
Network Panel: Located on the right side of the console, the Network panel, or Network View,
provides access to the remote management features in ShadowProtect. For more information, see
Chapter 10: Remote Management 60 .

5.1

Menu Bar
ShadowProtect Console has a menu bar that includes the following menus:
Table 9: Shadow Protect console m enus

Menu
File

Description
Access
applicationlevel options.
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Access
Backup: Launches the Backup Wizard (see Chapter 6: Creating Backup
ShadowProtect Image Files 38 ).
Wizards.
Restore: Launches the Restore Wizard (see Chapter 8: Restoring a Volume
54 ).
Explore Backup: Launches the Explore Backup Image Wizard (see Chapter
7: Mounting Backup Image Files 49 ).
Dismount Backup Image: Launches the Backup Image Dismount Wizard (see
Section 7.3: Dismounting Backup Image Files 52 ).

Tasks

Verify Image: Launches the Verify Image Wizard (see Section 13.1: Verifying
Backup Image Files 76 ).
Backup Image Tool: Launches the Backup Image Tool Wizard (see Chapter
9: Backup Image Tool 57 ).
Add Destination: Opens the Destination dialog box where you can create
named destinations for backup image files(see Section 6.2: Destinations

41

).

Refresh Volume Info: Refreshes the ShadowProtect volume list for the current
system.

View

Create custom
toolbars and
manage
toolbar
visibility.

Toolbars: Opens the Customize Tool Bar dialog box, where you can create
customized tool bars for the ShadowProtect UI.
Status Bar: Toggles a status bar at the bottom of ShadowProtect Console that
provides application and environment status information.
Task Panel: Toggles visibility of the Navigation Panel (see Navigation Panel
27 ).

Access
Agent Options: Opens the Agent Options dialog box where you can configure
Options ShadowProtect Email notification settings for the current system. You can choose to send
Agent options. Email notifications for both failed and successful backup jobs.
Access
Contents: Launches the ShadowProtect on-line help system. The help is
ShadowProtect available only when running ShadowProtect Console in Windows (not in the
help
Recovery Environment).
resources.
About: Displays the ShadowProtect version and copyright information. Click
System Info to open the Microsoft System Information dialog box, which
contains detailed information about the computer.
Help
Product Activation: Opens the Activation dialog box, where you can activate (or
deactivate) the ShadowProtect installation (see Section 4.4: Activating
ShadowProtect 21 ).
Check for Latest Version: Queries the StorageCraft Web site for updates to
the current ShadowProtect installation. If there is an update available, a
message displays the URL where you can get the update.
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Navigation Panel
The left-side Task panel provides quick access to ShadowProtect tasks and tools. You can toggle the
Navigation panel on or off by selecting View > Task Panel. The Navigation panel is organized into the
following categories. You can collapse and expand each category, as desired.
Table 10: Shadow Protect task panel options

Categor
y

View

Description

Options

Network View: Displays the nodes running the ShadowProtect Backup
Display or hide the Agent (see Chapter 10: Remote Management 60 ).
Network View.
Management View: Displays the Management View in the Main panel
(see Management View Tab

35

).

Backup: Launches the Backup Wizard (see Chapter 6: Creating Backup
Image Files 38 ).
Restore: Launches the Restore Wizard (see Chapter 8: Restoring a
Volume 54 ).
Explore Backup: Launches the Explore Backup Image Wizard (see
Chapter 7: Mounting Backup Image Files 49 ).

Tasks

Access
ShadowProtect
Wizards.

Dismount Backup Image: Launches the Backup Image Dismount
Wizard (see Section 7.3: Dismounting Backup Image Files 52 ).
Verify Image: Launches the Verify Image Wizard (see Section 13.1:
Verifying Backup Image Files 76 ).
Backup Image Tool: Launches the Backup Image Tool Wizard (see
Chapter 9: Backup Image Tool 57 ).
Add Destination: Opens the Destination dialog box where you can create
named destinations for backup image files (see Section 6.2:
Destinations 41 ).
Refresh Volume Info: Refreshes the ShadowProtect volume list for the
current system.
Note: Several tools are available only in the Recovery Environment
(RE). For more information about these tools, see the
StorageCraft Recovery Environment User Guide.
Verify Image: Launches the Verify Image Wizard (see Section 12.1:
Verifying Backup Image Files 76 ).

Tools

Access
ShadowProtect
tools.

Backup Image Tool: Launches the Backup Image Tool Wizard (see
Chapter 9: Backup Image Tool 57 ).
Refresh Volume Info: Refreshes the ShadowProtect volume list for the
current system.
Network Configuration: (RE only) Launches the Network Configuration
utility, where you can configure a computer's network access settings.
HIR Configuration: (RE only) Launches the Hardware Independent
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Restore (HIR) utility, where you can restore a backup image to a different
environment from which it was created.
Load Drivers: (RE only) Opens the Load Drivers dialog box, where you
can configure storage drivers for use in the Recovery Environment.
File Browser: (RE only) A simple file browser that lets you browse files
and folders of a backup image file.
Text Editor: (RE only) A simple text editor.
Vista BCD: (RE only) Launches the Vista BCD editor, where you can edit
Boot Configuration Data (BCD) on systems running Windows Vista.
Partition Table Editor: (RE only) A simple partition table editor.
UltraVNC: (RE only) Launches the Remote Management utility, where
you can configure remote access to systems running the Recovery
Environment.
Select Your Time Zone: (RE only) Launches the Time Zone utility, where
you can adjust the system's time zone information.
Enable Logging: (RE only) Opens the Logging dialog box, where you can
configure ShadowProtect event logging.
Backup: Opens the on-line help to Chapter 6: Creating Backup Image
Files 38 .

Help

(Windows only)
Access to on-line
help topics.

Restore: Opens the on-line help to Chapter 8: Restoring a Volume

54

.

Browse Image: Opens the on-line help to Chapter 7: Mounting Backup
Image Files 49 .
Image Tools: Opens the on-line help to Chapter 9: Backup Image Tool
57 .

License

Info

Status

(Windows only)
Displays current
licensing
information for this
ShadowProtect
installation.

Trial or Evaluation version: Displays the number of days before the
ShadowProtect installation expires.

(RE only) Display
system
information.

A quick reference to basic system information, including Computer
Name, IP Address and Time Zone information.

Licensed version: Displays "Active", meaning that the product is fully
licensed and activated.

(RE only) Displays Queued Tasks: The number of queued tasks waiting to run.
the current state of
Running Tasks: The number of tasks currently running.
the system,
including:
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Tabs
The ShadowProtect Console provides the following pages in the Center panel:
Wizards

29

Disk Map Tab

30

Backup Jobs Tab
Destinations Tab

31
33

Backup History Tab

34

With the exception of the Management View, you can close a tabbed page by selecting it, then
clicking the Close icon to the right side of the tab list. Once closed, you can re-open a tab for a
particular node by right-clicking the node in the Management View, then selecting the tab to open from
the drop-down list.

Wizards
The Wizards pane is the default state of the Main panel if no tabs are displayed. It provides access to
three Wizards (Backup, Restore, and Explore Backup) that guide users through the most common
ShadowProtect tasks.

Shadow Protect Wizards tab

Backup: Starts the Backup Wizard, which guides you through the creation of a backup job. For
more information, see Chapter 6: Creating Backup Image Files 38 .
Restore: Starts the Restore Wizard, which guides you through the process of restoring a
© 2010 StorageCraft Technology Corporation
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volume from a backup image file. For more information, see Chapter 8: Restoring a Volume
for additional information.

54

Explore Backup: Starts the Explore Backup Wizard, which guides you through mounting a
backup image file as a volume so you can restore individual files and folders. For more
information, see Chapter 7: Mounting Backup Image Files 49 .

Disk Map Tab
The Disk Map tab provides a graphical view of system drives. Disk Map lists each physical disk drive
with the partitions available on that drive.

Shadow Protect Disk Map tab

Right-clicking an entry in the Disk Map opens an actions menu for that entry.
Table 11: Disk Map action m enu options

Entry
Physical
Drive

Right-click Actions
Edit Policy: Opens the Partition Creation Policy Editor dialog box.
Refresh Volumes Info: Refreshes the ShadowProtect volume list for the current system.
Backup: Launches the Backup Wizard (see Chapter 6: Creating Backup Image Files
).
Restore: Launches the Restore Wizard (see Chapter 8: Restoring a Volume

54

38

).

Delete Partition: Deletes the selected partition.
Partition

Set Active: Sets the selected partition as the active (bootable) partition on the physical
drive.
Edit Policy: Opens the Partition Creation Policy Editor dialog box. For more information,
see Section 12.5: Changing Partiton Creation Policy 81 .
Refresh Volumes Info: Refreshes the ShadowProtect volume list for the current system.

The Disk Map tab lets you access the Backup and Restore Wizards, and change partition creation
policies for the selected drive. Additionally, in the Recovery Environment you can also run Check Disk,
format a drive and edit the selected disk's boot.ini.
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Backup Jobs Tab
The Backup Jobs tab displays scheduled backup jobs. From this tab, you have complete control over
the ShadowProtect jobs configured for the current system.

Shadow Protect Backup Jobs tab

The Backup Jobs tab is divided into two panes:
Job Controls Pane: The upper Job Controls pane lets you manage backup jobs. Select a backup job
from the job list to manage it, and view job information in the Job Information pane. The Job Controls
pane includes the following controls:
Table 12: Controls in the job control pane

Control

Description

Execute

Executes the selected backup job.

Cancel

Cancels the selected backup job. This terminates a currently running job, but keeps the
job status as enabled (the job executes at its Next Run Time).

Pause

Toggles the selected job status between enabled and disabled. A disabled job is
suspended and will not run until re-enabled.
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New

Launches the Backup Wizard (see Chapter 6: Creating Backup Image Files

Delete

Deletes the selected job from the Job Scheduler.

Edit

Launches the Backup Wizard, where you can edit the selected job's configuration (see
Chapter 6: Creating Backup Image Files 38 ).

Details

Opens the Volume Backup tab in the Job Information pane so you can see details about
the currently selected backup job.

Refresh

Refreshes the volume information in the Backup Job Information pane.

38

).

Job Information: Displayed in the lower pane, the Job Information pane includes two tabs that
provide information about the currently selected backup job.
Table 13: Tabs in the job inform ation pane

Component

Description
Displays information about the currently selected backup job in three panes:
Job Status: Displays information about the current backup job, including the
destination backup image file, and status (queued, running, completed), and the
time remaining (running job) or total time (completed job). Click View Details to view
the Volume Backup tab.

Basic Properties
Backup Job: Displays information about the backup job configuration, including
Compression, Encryption, and the backup job options.
Schedule: If the selected backup job is a recurring job, the Basic Properties tab
displays the job schedule for both Full backup images, and Incremental backup
images, where applicable.

Volume Backup

Displays detailed information about the currently running backup job, including time
remaining, throughput, and an Event log. If no backup job is running, the Volume
Backup tab displays details from the most recent backup job.
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Destinations Tab
The Destinations tab displays information about the system's named destinations, which are predefined storage locations for backup image files. From this tab, you have complete control over the
Destinations defined on the current system. For more information see Section 6.2: Destinations 41 .

Shadow Protect Destinations tab

The Destinations tab includes the following panes:
Destinations List: The upper pane displays a list of currently defined Destinations for the system.
To delete or edit a destination location, highlight the destination location in the list and then select
the operation to perform. Information about backup Image Sets stored at the destination location is
presented for the highlighted entry in the Destination Information.
Destination Usage: The lower pane displays information about the backup Image Sets stored in the
currently selected Destination, including Base Name, First Image Creation Time, Last Image
Creation Time and number of "point-in-time" image files in the backup Image Set.
Additionally, the Destinations tab includes the following icons for working with Destinations:
Add: Opens the Destination dialog box (see Section 6.2: Destinations

41

for additional information).

Delete: Deletes the currently selected Destination.
Edit: Opens the Destinations dialog box so you can modify an existing Destination configuration
(see Section 6.2.1: Editing Destinations 43 ).
Refresh: Updates the Destination Objects List and the Destination Objects Information List.
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Backup History Tab
The Backup History tab displays log information for completed backup jobs. The Backup History lets
you analyze ShadowProtect backup activity over time, including failed jobs, if any.

The Backup History tab

The Backup History tab includes the following panes:
Job History: The upper pane displays a list of completed backup jobs. Select a job to view job
details in the Job Log.
Job Log: The lower pane displays the log entries for the selected job. This is the same information
available in the Volume Backup tab (see Backup Jobs Tab 31 .)
You can sort the backup history lists by clicking on the column headers. You can also adjust the
column width by dragging the column header borders.
Additionally, the Backup History tab includes the following icons:
Delete All: Clears the Job List.
Details: Displays or hides the Job Log pane.
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Management View
The Management View is one way to access the remote management capabilities of ShadowProtect.
It is the preferred management view for users of ShadowProtect Server and ShadowProtect SBS
because it lets you easily manage many nodes from a single location.

The Management View tab is divided into two panes:
Node Controls Pane: The upper Node Controls pane lets you manage connected nodes. Select a
node from the Node Information pane to manage it. The Node Controls pane includes the following
controls:
Table 11: Controls in the job control pane

Control
Connect

Disconnect

Description
Connects a previously added managed remote node to the ShadowProtect user
interface.
Disconnects a managed remote node from the ShadowProtect user interface.

Add

Adds a system that has the ShadowProtect Backup Agent installed to the node list.

Delete

Deletes a remote node from the managed node list.

Edit

Opens the Server Details dialog box of the currently selected node (see Modifying
Remote Node Properties 65 ).

Manage

Opens the ShadowProtect tabs (Disk Map, Backup Jobs, Destinations, Backup
History) for the currently selected node.

Install

Opens the ShadowProtect Push Wizard, which lets you push the ShadowProtect agent
out to other systems that you want to manage from this Management View. For more
information, see Installing the Backup Agent Remotely 60 .

Node Information List: The Node Information pane displays a list of nodes currently managed by this
management console.
Table 12: Tabs in the job inform ation pane

Component

Description
Displays information about the currently selected backup job in three panes:

Basic Properties

Job Status: Displays information about the current backup job, including the
destination backup image file, and status (queued, running, completed), and the
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time remaining (running job) or total time (completed job). Click View Details to view
the Volume Backup tab.
Backup Job: Displays information about the backup job configuration, including
Compression, Encryption, and the backup job options.
Schedule: If the selected backup job is a recurring job, the Basic Properties tab
displays the job schedule for both Full backup images, and Incremental backup
images, where applicable.

Volume Backup

5.5

Displays detailed information about the currently running backup job, including time
remaining, throughput, and an Event log. If no backup job is running, the Volume
Backup tab displays details from the most recent backup job.

Network View
The Network view displays information for managing ShadowProtect on remote systems (see Chapter
10: Remote Management 60 ).

The Netw ork View panel

The Network View includes the following controls:
Table 14: Controls in the job control pane

Control
Connect

Disconnect

Description
Connects a previously added managed remote node to the ShadowProtect user
interface.
Disconnects a managed remote node from the ShadowProtect user interface.
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Add

Adds a system that has the ShadowProtect Backup Agent installed to the node list.

Delete

Deletes a remote node from the managed node list.

Refresh

Refreshes the remote node list.

Properties
Import Nodes
Export Nodes

37

Toggles the Server Properties table on and off.
Imports a previously exported node list into your Network View.
Exports your node list into an XML file.
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Chapter 6: Creating Backup Image Files
Note: For information about creating a backup image file in Recovery Environment, see the
StorageCraft Recovery Environment User Guide.
ShadowProtect provides two ways to create backup image files:
One-Time Backup: The Backup Wizard guides you through creating a backup image file
immediately. Consider the following when creating a one-time backup job:
To create a one-time backup job, you must be a member of the Administrator group on the
system where you are creating a backup.
One-time backup jobs do not affect scheduled backup jobs.
ShadowProtect supports one-time backup images from both Windows and Recovery
Environment. For more information about each of these options, see Section 2.1: Features
and Components 8 .
Scheduled Backup: The Backup Wizard guides you through the process of creating a recurring
backup job (see Chapter 6: Creating Backup Image Files 48 ). Consider the following when creating
a scheduled backup job:
A volume can belong to no more than one scheduled backup job that includes Incremental
backups. This limitation does not include one-time backup images or Differential backup
images, as long as they do not disrupt sector tracking for the Incremental backup.
If ShadowProtect is currently running a backup job, or the computer is turned off and
unavailable, ShadowProtect skips any scheduled backup jobs during that time.
ShadowProtect supports scheduled backup images only from Windows (not Recovery
Environment).
To create a backup image file
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

Start the Backup Wizard, then click Next.

21

).

There are several ways to start the Backup Wizard, including:
In the Wizards tab, click Backup.
In the Tasks menu, click Backup.
In the Menu Bar, select Tasks > Backup.
3.

On the Volumes to Back Up page, select the volumes to backup, then click Next.
ShadowProtect creates a separate backup file for each volume.

4.

On the Backup Name and Destination page, specify the following information about the backup
image file, then click Next.
Location

You can select either a local drive or network location to store the backup image file:
Local Drive: Click Browse. In the Open Folder dialog box, select the local drive
and folder to store the backup image file.
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Network Share: In the drop-down list, select <Network Locations>. This opens
the Destinations dialog box where you can define the network share. For more
information, see Section 6.2: Destinations 41 .
Name

5.

The File Name table displays the volumes (with default file names) selected for the
backup job. Double-click a table row to modify the file name.

On the Specify the Backup Schedule page, specify the schedule and backup image type, then
click Next.
Note: The selected backup schedule determines the available backup image types. For
more information about the backup image types, see Chapter 16: Glossary 86 .
Now

Full
Differential

Later

Full

Creates a one-time backup job that starts as soon as
the Backup Wizard closes.
Creates a one-time backup job at the specified date
and time.
By default, the Start Time fields display the current
date and time. To change the date and time settings,
click on an element of the date/time (month, day, year,
hour minute, second, AM/PM), then type or use the up/
down buttons to set the desired value.

Weekly

Full
Incremental

Creates a recurring backup job based on a weekly
schedule. You select the weekdays and time of day to
start a Full backup.
Optionally, you can specify a schedule for Incremental
backups.
a. Select the weekdays to create Incremental backups.
b. Specify times of day to start and stop creating
Incremental backups.
c. Specify the Incremental backup frequency (minutes
between Incremental backups).

Monthly

Full
Incremental

Creates a recurring backup job based on a monthly
schedule. You select the days of the month and time
of day to start a Full backup.
Optionally, you can specify a schedule for Incremental
backups.
a. Select the weekdays to create Incremental backups.
b. Specify times of day to start creating Incremental
backups.

Continuous
Incrementals

Incremental

Creates a single Full backup, then creates recurring
Incremental backups from that point forward. This
option requires ShadowProtect ImageManager (see
the ShadowProtect IimageManager User Guide.).
To specify the Incremental backup schedule:
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a. Select the weekdays to create Incremental backups.
b. Specify times of day to start and stop creating
Incremental backups.
c. Specify the Incremental backup frequency (minutes
between Incremental backups).

6.

(Conditional) On the Previous Backup Image page, select the existing backup image file to use
as a basis for creating the Differential backup image, then click Next.
This page displays only when you specified a Differential backup in the Backup Schedule
page.

7.

On the Options page, select the desired backup image file options, then click Next.
The Options page lets you set both basic and advanced backup image options. For more
information about each of the available options, see Backup Image File Options 43 .

8.

On the Wizard Summary page, review the backup job configuration, then click Finish.
Select Execute Now to run the backup job immediately in addition to the schedule defined in
the job.

You can monitor the progress of the backup in the Backup Jobs tab (see Section 5.3.3: Backup Jobs
Tab 31 ).

6.1

Backup Image File Storage Locations
ShadowProtect lets you store backup image files on any disk device, including hard drives,
removeable USB/FireWire drives, network drives and NAS (Network Attached Storage) devices. You
can also store backup images to optical media such as CDs, DVDs, or Blu-Ray discs.

Note: If you select a destination that does not have enough disk space to save the backup
image, the backup job fails due to lack of destination storage space. ShadowProtect notes the reason
for the failure in its log file.
Table 15: Advantages and disadvantages for various storage locations

Location

Advantages

Disadvantages

Local Hard Drive

Fast backup and restore.
Inexpensive.

Consumes local disk space.
Vulnerable to loss if the drive fails.

Local USB/FireWire
Drive

Fast backup and restore.
Preserves disk space on local
drives.
Inexpensive.
Easy off-site storage.

More expensive than local hard drives.
Vulnerable to loss if the drive fails.

Network Hard Drive

Fast backup and restore.
Protection from local hard
drive failure.
Off-site storage.

Must have network interface card drivers
supported by Recovery Environment.
Complexity. Users must have network
rights to save and access backup images.

CD/DVD/Blu-Ray

Good media for archiving.
Protection from local hard

Slower backups due to media speeds.
File restrictions due to limited size.
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Disadvantages

drive failure.

6.2

Destinations
Backup destinations let you create pre-defined storage locations for backup image files, either locally
or on a network. You can then select these destinations when creating backup jobs. Then, if you need
to modify the destination, you can do so by editing the destination object rather than deleting and
recreating new backup jobs.

The Shadow Protect Destinations tab

Note: ShadowProtect requires that every system has a unique Destination for its backup image
files. Multiple systems should not save files to the same folder.
To create a backup job destination
1.

Open the ShadowProtect Console, then select Tasks > Add Destination.
This opens the Destinations dialog box. You can also open the Destinations dialog box from
the Backup Name and Destination page of the Backup Wizard (see Chapter 6: Creating
Backup Image Files 38 ).
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Destinations dialog box

2.

Specify the settings for the new destination, then click OK.
Destination Type Select the type of destination to create:
Local Directory: The destination is on a locally connected storage device (HDD,
USB drive, etc.)
Network Share: The destination is on the network.
Destination
Name

Specify the path to the a descriptive name for this destination.

Destination Path Specify the details of the destination. The information you need to provide
depends on the Destination Type.
Local Directory: Click Browse, then select the local drive and folder to store
backup images.
Network Share: Click Browse, then select the network location to store backup
images. You must also specify the network credentials that ShadowProtect
should use to access the specified network location:
ShadowProtect Backup Service credentials: Use the
Specific User credentials: Provide the Container (Domain, Computer name, or
NAS device name), Username and Password that ShadowProtect should use to
access this network share.
Verify
Destination
Access

Instructs ShadowProtect to verify the destination path and access credentials, if
necessary, before creating the Destination object.
If the destination access verification is not successful the program will alert you
that the destination could not be created as requested. You should then check
the path and credentials used to make sure they are accurate and retry creating
the destination.
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Editing Destinations
To edit a backup job destination
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

Select the Destinations tab.

3.

Select the destination to edit, then click Edit.

21

).

This open the Destination dialog box, which displays the current destination configuration.
From this dialog box, you can edit all Destination properties except the Destination Type
(Network Share or Local Directory).

Deleting Destinations
To delete a backup job destination
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

Select the Destinations tab.

3.

Select the destination to delete, then click Delete.

21

).

Note: Before deleting a Destination, make sure to modify or delete any backup jobs that use
the Destination or the jobs will fail. For information about editing backup jobs, see Section 5.3.3:
Backup Jobs Tab 31 .

6.3

Options
When creating a backup job, ShadowProtect provides the following backup image file options. The
Backup Wizard provides access to these options when you are creating a backup job (see Chapter 6:
Creating Backup Image Files 38 ).
Compression Method
Encryption

43

44

Split Image File

44

Backup Comment

45

Compression Method
ShadowProtect provides the following file compression options when creating a backup image file:
None: No data compression. If disk space is not an issue, this option provides the fastest data
backup.
Standard: Typically compresses data by about 40%. This is the default compression option, and
provides a balance between backup speed and disk space usage.
High: Typically compresses data by about 50%. This option requires the most system resources,
and results in the slowest data backup, but is useful when disk space is limited.
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File Protection
ShadowProtect provides the following file protection mechanisms when creating a backup image file.
This is particularly useful when storing backup image files on a network, or off-site, to help prevent
unauthorized access and use of your backup image files. If you select to protect the backup image
file, you must specify the correct password in order to mount or restore the backup image.
Password Protection: Assigning a password requires you to enter the correct password before
using the backup image file (for example, to restore a volume or create a Differential backup image
based on the password-protected file. ShadowProtect supports passwords comprised of
alphanumeric characters. Use the following guidelines when creating a password for the greatest
security with password encrypted backup image files.
Use at least eight characters.
Use a random mixture of characters, upper and lower case and numbers.
Don’t use a word found in the dictionary.
Change your password regularly or if you suspect your password has been compromised.
Warning: If you forget the password, you cannot access the backup image file.
StorageCraft cannot access an encrypted backup image file.
File Encryption: ShadowProtect uses the password as an encryption key when encrypting the
backup image file. You can select one of three encryption methods in the Advanced Options dialog
box. For more information, see "Encryption" in Section 6.3.5: Advanced Options 45 .
Use Password File: You can use password file, also known as a Key File, to encrypt a backup
image. This is helpful if you are not managing your own backups and you don’t want other users to
have access to the password used to protect the backup image files. For information about creating
a Key File, see Section 12.4: Creating Key Files 79 .

Split Image File
ShadowProtect lets you split a backup image file into multiple smaller files, creating a Spanned Image
Set. This is useful when you need to move a backup image file onto fixed length media such as CDs
or DVDs.
You can split a backup image file when you create it by selecting Split Image File in the Backup
Wizard's Options page. Once selected, specify the desired file size, in MB, in the Split Image File
field. For more information about the Backup Wizard, see Creating Backup Image Files 38 .
You can also split an existing backup image file using the Backup Image Tool (see Chapter 9: Backup
Image Tool 57 ).

Note: If a backup image file is divided into multiple files, the filename suffix will change to .sp1,
.sp2, ..., .spN, where N represents the file's sequence within the Spanned Image Set.
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Backup Comment
The Backup Comment option lets you attach a comment to a backup image file. These comments are
available for review when mounting or restoring the backup image file at a later date. By default the
time and date stamp are added to the backup image.

Advanced Options
ShadowProtect supports the following advanced options when creating a backup image job. You can
access advanced options from the Options page of the Backup Wizard (see Creating Backup Image
Files 38 ).

Advanced Options page in the Backup Wizard

ShadowProtect organizes its advanced options into four tabs:
Backup
Image

46

46

Commands
Retention

47

48

Note: StorageCraft recommends using the default advanced option settings unless you fully
understand the impact of changing these features.
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Backup
The Backup tab includes the following advanced options:
Include free space: (Default = Off) Backs up all sectors on the volume, including those sectors
marked as free space. This can result in a much larger image file, but can help preserve previously
deleted files.
Performance throttling: (Default = On, 100% I/O usage) Specifies how much I/O bandwidth that
ShadowProtect can use when creating a backup image file. Use the slider bar to adjust this setting.
Reducing (throttling) ShadowProtect I/O usage increases the time it takes to create a backup image
file, but can reserve I/O bandwidth for other processes.
2nd and subsequent full backups are differentials: (Default = Off) Instructs ShadowProtect to
create Differential images rather than Full images for second and subsequent scheduled backup
jobs. For example, if you have a weekly backup schedule that creates a new Full image each
Monday, selecting this option instructs ShadowProtect to create Differential images each Monday
that are based on the initial Full image created when the backup job ran for the first time. This
reduces storage needs for the backup image files over time.
Generate MD5 file when creating an image file: (Default = On) Instructs ShadowProtect to
create an MD5 (Message Digest 5) checksum file when creating a backup image file. The checksum
lets you confirm the file integrity of backup image files.
Ignore read failures and continue backup: (Default = Off) Instructs ShadowProtect to ignore disk
read errors that occur during the creation of backup image files.

Image
The Image tab includes the following advanced options:
Enable write caching: (Default = Off) Enables or disables using file caching when writing the
backup image file. Turning this option on might slow down the imaging process.
Enable concurrent task execution: (Default = Off) Enables or disables creating backup images
simultaneously for multiple volumes rather than creating only one backup images at a time. When
using this option, you should have hardware capable of supporting a high disk load.
Enable self-healing incremental recovery: (Default = On) Determines how ShadowProtect reacts
to a system error that interrupts the ShadowProtect incremental tracking feature. When Off,
ShadowProtect recovers by generating a new Full image and starting a new Image Set. When On,
ShadowProtect recovers by creating an Incremental image as planned, along with a Differential
image based on the most recent Incremental image and the current volume. This prevents disruption
of the Incremental backup schedule, but can result in increased CPU and network bandwidth when
compared to creating a new backup Image Set.
Auto-execution of unexecuted task: (Default = On) Enables or disables executing the last
scheduled backup job if it was missed (for example, because the system was powered off). This
option executes only the last unexecuted backup job if ShadowProtect misses more than one
scheduled backup job.
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Commands
The Commands tab lets you specify command files (.exe, .cmd, .bat) to execute at key points in
the backup image file creation process. The command files cannot rely on any user interaction, so you
should test each command file before using them with ShadowProtect. ShadowProtect allows 5
minutes at each stage (Pre-snapshot, Post-snapshot, and Post-backup) for command files to
complete. If the command files do not complete in 5 minutes, ShadowProtect proceeds while the
command files continue executing.
To use a command file, enter the full file name, including path, into the appropriate field:
Pre-Snapshot: Executes the specified command file before taking the image snapshot (see
"Snapshot" in Chapter 16: Glossary 86 ). For example, you might execute a pre-snapshot command
file that places non-VSS aware applications or databases into a backup state.
Note: It takes only a few seconds to create a snapshot, so non-VSS databases or
applications are out of production only briefly before they can be returned to normal operating
mode with a post-snapshot command.
Post-Snapshot: Executes the specified command file after taking the image snapshot (see
"Snapshot" in Chapter 16: Glossary 86 ). For example, you might execute a post-snapshot
command file to return non-VSS aware applications or databases to normal operating mode.
Post-Backup: Executes the specified command file after creating the backup image file. For
example, you might execute a post-backup command file to automatically copy the backup image
file to an off-site location or FTP server.
Note: To avoid the 5 minute execution limit for post-backup command files, you can call a
command file that simply executes another command file and then finishes. This lets you
complete the ShadowProtect-associated command file in the 5 minute allotment while the
secondary command file performs tasks that take longer to complete (synchronizing or copying
the backup image files to an alternate location, scanning the backup image file for viruses, etc.

Encryption
The Encryption tab lets you select the algorithm used to encrypt the backup image file. The
Encryption tab is displayed only when you have selected Enter Password on the Options page of the
Backup Wizard (see Section 6.3.2: File Protection 44 ).
RC4 128-bit: This encryption option is the fastest, but least secure of the algorithms.
AES 128-bit: This encryption option strikes a balance between speed and security.
AES 256-bit: This encryption option is the most secure, but slowest, of the algorithms.
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Retention
The Retention tab lets you specify a policy for automatically managing the retention of backup Image
Sets (see "Image Set" in Chapter 16: Glossary 86 ). The Retention tab is not available if you are using
the Continuous Incremental backup schedule, which leverages ShadowProtect ImageManager to
manage backup Image Sets. For more information, see the ShadowProtect IimageManager User
Guide.
The Retention tab includes the following advanced options:
Enable a retention policy: (Default = Off) Enables or disables an automatic Image Set retention
policy.
Number of backup Image Sets to retain: (Default = 3) Specifies the maximum number of Image
Sets to retain. When the specified maximum (M) is reached, ShadowProtect deletes the oldest
Image Set. By default, ShadowProtect enforces the retention policy after creating an Image Set,
meaning that ShadowProtect creates the M+1 Image Set, then deletes the oldest Image Set,
thereby retaining M Image Sets.
Delete both Full and Incremental backup images in the set: (Default = Off) Instructs
ShadowProtect to delete the all files, both Full and Incremental, when removing an old Image Set.
Delete only Incremental backup images (retain Full backup images): (Default = On) Instructs
ShadowProtect to delete only Incremental backup images when removing an old Image Set.
Enforce policy before starting the next Full backup: (Default = Off) Instructs ShadowProtect to
"make room" for a new Image Set by deleting the oldest Image Set before creating the new Image
Set that will replace it. This reduces the amount of disk space needed to adhere to the specified
retention policy.
For more information about the benefits of retention policies, see Chapter 14: Common Retention
Policy Configurations 84 .

6.4

Deleting Backup Image Files
You can delete backup image files using any process you normally use to delete a file in Windows.
However, before deleting a backup image file, be certain of the following:
The backup image file is not required for any active backup job. If you delete the Full image to
an active backup image job, ShadowProtect creates a new Full image at the next scheduled
backup and starts a new Image Set.
Other backup image files do not depend on this backup image file. If you delete a backup image
file that other point-in-time backup image files depend on, all dependent backup image files
become useless. You cannot browse and restore files from these dependent backup image files.
Use the Backup Image Tool to check for any file dependencies (see Chapter 9: Backup Image
Tool 57 ).
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Chapter 7: Mounting Backup Image Files
The ShadowProtect Explore Backup Wizard guides you through the process of mounting a backup
image file. ShadowProtect automatically associates the files required to browse and restore a specific
backup image file. You need only select the backup image you want to explore. Once mounted, you
can treat the backup image file as you would any other Windows volume:
Browse the backup image file.
Share the backup image file.
Copy individual files and folders from the backup image file.
Modify the backup image file (if the volume is configured as writeable).
Use standard Windows security and file properties.
While the process is the same, whether you can restore files and folders in Windows, or need to use
the StorageCraft Recovery Environment, depends specifically on the state of your system and what
you need to restore:
Restore in Windows: Windows loads, but you have lost data or had undesirable changes to
applications or hardware files on a volume (excluding the operating system files).
Restore in Recovery Environment: Windows does not load and you have lost data or operating
system files, or had undesirable changes to applications or hardware files on a volume. For more
information, see the StorageCraft Recovery Environment User Guide.
Note: To restore data from an Incremental image, you must have all previous incremental
backup image files and the initial full backup image. If any of these files is missing or corrupt,
mounting the backup image to that point in time is not possible. ShadowProtect does not let you
modify Full images prevent corrupting an entire Image Set.
For information about mount options, see Backup Image Mount Options

51

.

To mount a backup image file
1. Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

2. Open the Explore Backup Wizard by doing one of the following:
In the Wizards tab, click Explore Backup.
In the Tasks menu, click Explore Backup.
In the Menu bar, select Tasks > Explore Backup.
3. On the Backup Image File Name page, browse to the backup image file you want to mount,
then click Next.
For information about backup image file naming conventions, see Section 3.3.1: File Naming
Conventions 16 .
Note: If the backup image is encrypted you must provide the appropriate password.
The Explore Backup Image Wizard displays a categorized list of information about the backup
image file.

© 2010 StorageCraft Technology Corporation

50

ShadowProtect User Guide

Select Backup Im age File to Brow se

4. (Conditional) In the Backup Image Dependencies page, select the desired point-in-time image
from the selected backup Image Set, then click Next.
5. On the Explore Options page, select how you want to mount the backup image, then click Next
.
For more information about mount options, see Backup Image Mount Options

51

.

a. To mount the backup image file as a drive letter, select Assign the following drive letter,
then select the appropriate drive letter from the drop-down list.
b. To mount the backup image file as a mount point, select Mount in the following empty
NTFS folder, then browse to the appropriate NTFS folder. You must also specify how to
name the mount point sub-folder:
Time/Date: Uses the backup image's creation date and time as the sub-folder name (for
example, 7-12-2008 10.19.24 AM).
File Name: Uses the backup image file name as the sub-folder name (for example,
E_VOL b001).
Custom: Lets you specify a custom sub-folder name.
c. (Optional) Deselect Mount Backup as Read-Only to mount the backup image as a
writeable volume.
If you mount the backup image file as a writeable volume, you can choose to save the
changes to an Incremental image file when you dismount the volume (see Dismounting
Backup Image Files 52 ).
6. On the Wizard Summary page, review the mount information, then click Finish.
ShadowProtect mounts the backup image file, then automatically launches Windows Explorer
and displays the mounted volume.
7. With the backup image mounted, you can browse the contents of the volume as you would any
Windows volume.
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To restore individual files or folders, simply copy them from the backup image file volume to
your production volume.
Note: Once mounted, select Refresh Volumes Info to get an accurate view of the mounted
system volumes from the Disk Map tab.

7.1

Mounting Backup Image Files in Windows
ShadowProtect adds two options to the Context menu (the right-click menu) of backup image files:
Mount: Launches the Image File Mount Wizard to guide you through the process of mounting the
selected backup image file. For information about the various options in the Image File Mount
Wizard, see Mounting Backup Image Files 49 , starting in Step 3. You can simultaneously mount
multiple backup image files, but you must mount each backup image file individually with the Image
File Mount Wizard.
Quick Mount: Mounts the backup image file as read-only using the next available drive letter. You
can select multiple backup image files, then quick mount them simultaneously, with each backup
image file receiving the next available drive letter.
For information about dismounting a backup image file, see Dismounting Backup Image Files

7.2

52

.

Backup Image Mount Options
When mounting a backup image file, consider the following:
Whether to mount the backup image as a drive letter or at a mount point location.
Whether to mount the backup image as read-only or writeable.

Mounting a Backup Image as a Drive Letter
The ShadowProtect Mount Utility lets you mount a backup image file as a drive letter on your
computer with all the properties of the original volume.
After mounting a backup image as a drive letter, you may perform a variety of tasks, such as
running ScanDisk (or CHKDSK), performing a virus check, defragmenting the drive, copying
folders or files to an alternate location or simply viewing disk information about the drive such as
used space and free space.
When a drive is mounted, you may set it up as a shared drive. Users on a network can connect
to the shared drive and restore files and folders from within the backup image if you want end
users to recover their own files. You also may mount one or more backup images at a time. The
drives will remain mounted until you dismount them or restart the machine. If an NTFS volume
uses EFS (Encrypted File System), the security remains intact on the volume when it is
mounted.

Mounting a Backup Image as a Mount Point
The ShadowProtect Mount Utility lets you mount a backup image file as a mount point (a
directory on an NTFS file system). Mount points overcome the available drive letter limitation and
support more logical organization of files and folders.
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Mounting a Read-Only Backup Image
By default, ShadowProtect mounts backup image files as read-only. This lets users access the
backup image to do the following:
Recover files from an existing backup image.
View the contents of a backup image.
Run other applications that need to access the backup image, such as a storage resource
manager or data mining application.
Note: Windows 2000 does not support read-only NTFS volumes.

Mounting a Writeable Backup Image
ShadowProtect can mount a backup image as writeable volume. This lets users access the
backup image to do the following:
Remove files from the backup image (viruses, malware, etc.)
Add files to the backup image.
Update the backup image security.
Restore a backup image to a smaller volume (see Dismounting Backup Image Files

52

).

Note: ShadowProtect prevents you from modifying a Full image file to prevent corruption of
an entire Image Set.

7.3

Dismounting Backup Image Files
Once mounted, a backup image file remains mounted until explicitly dismounted, or the system
reboots. The ShadowProtect Backup Image Dismount Wizard guides you through the process of
dismounting a previously mounted backup image file (see Mounting Backup Image Files 49 ). As part
of the dismount process, you can do the following:
Save changes to writeable backup images.
Shrink the volume so you can restore the image to a smaller drive.

Note: The Shrink Volume feature truncates mounted backup image files so that the file
system ends at the last currently-allocated cluster. To reduce the backup image size
as much as possible, use a disk defragmentation tool on the mounted image to
consolidate file distribution within the volume and free up space at the end of the
volume.
To dismount a backup image
1. Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

2. Open the Backup Image Dismount Wizard by doing one of the following:
In the Tasks menu, click Dismount Backup Image.
In the Menu bar, select Tasks > Dismount Backup Image.
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3. In the Mounted Backup Images page, select the backup image volume to dismount, then click
Next.
When selecting a mounted backup image, this page also displays the volume properties.
4. (Conditional) In the Backup Image Dismount Options page, select if you want to Save volume
changes, or Shrink the backup Image, then click Next.
These options are available only if the backup image volume is writeable (see Backup Image
Mount Options 51 ).
Save changes to incremental file: Saves changes made to the mounted volume. Rightclick the Incremental File to save the modified backup image file using a different name.
Shrink Volume: Lets you shrink the volume so you can restore this image to a smaller hard
drive. This option is available only in the following situations:
Dismounting a writeable backup image of an NTFS volume in Windows Vista or
Windows Server 2008 (or later).
Running StorageCraft Recovery Environment using boot option 1 (Recommended),
which boots using Windows PE (Vista-based).
5. In the Backup Image Dismount Summary page, review the dismount details, then click Finish.
Note: Once dismounted, select Refresh Volumes Info to get an accurate view of the mounted
system volumes from the Disk Map tab.

Dismounting Backup Images in Windows
ShadowProtect adds two options to the Context menu (the right-click menu) of mounted backup image
files. For information about mounting backup image files, see Mounting Backup Image Files 49 .
Dismount: Launches the Backup Image Dismount Wizard to guide you through the process of
dismounting the selected backup image file. For information about the various options in the Backup
image Dismount Wizard, see Dismounting Backup Image Files 52 , starting in Step 3.
Quick Dismount: Dismounts the backup image file without any further user interaction.
ShadowProtect dismounts the backup image file without saving changes made to a writeable
mounted image file, if applicable.
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Chapter 8: Restoring a Volume
ShadowProtect provides two ways to restore volumes from backup image files:
Restore in Windows: Restore a non-system volume using the ShadowProtect Restore Wizard.
This method does not require you to reboot the system.
Restore in Recovery Environment: Use the bootable Recovery Environment when restoring a
system volume where the operating system resides. For information about restoring a system
volume from the Recovery Environment, see the StorageCraft Recovery Environment User Guide.
Warning: Restoring a backup image to a volume overwrites all data currently on the
volume.
To restore a non-system volume
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

Open the Restore Wizard by doing one of the following:

21

).

In the Wizards tab, click Restore.
In the Tasks menu, click Restore.
In the Menu bar, select Tasks > Restore.
3.

On the Backup Image to Restore page, select the Image Set to restore, then click Next.
In the drop-down menu, select the Destination (see Section 6.2: Destinations 41 ) that
contains the backup Image Set to restore, or click Browse to locate the desired backup
image set. The Specify Image Names field displays the backup Image sets available at the
selected destination or path.

Select the backup im age set to restore

Note: To restore a volume from a backup image set stored on a network share, you must
have the proper network credentials.
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On the Backup Image Dependencies page, select the point-in-time to restore, then click Next.

Select specific point-in-tim e to restore

This page displays all Incremental backup image files associated with the selected Image
Set. Select a specific backup image file to view the following image file properties:
Image File Properties: Volume size, creation time, compression, password protection,
comment.
Original Partition Information: Style, number, type, bootable option, starting offset and
length.
Disk Information: Disk geometry, disk size and number of the first track sectors. You can
also view the disk layout graphically at the bottom of the screen. This represents what the
disk looked like at the time of backup.
Originating machine: Operating system version, the machine name, MAC address and
the ShadowProtect engine version used to create the image file.
5.

On the Restore Destination page, select the volume where you want to restore the backup
image, then click Next.
Note: The selected partition must space sufficient for the selected Image Set. For
example, you cannot restore a 4GB backup file with only 1GB of free space.
Right-click a volume to see the following actions in the context menu:
Delete Volume: Deletes the selected volume. The deleted volume becomes unassigned
space on the disk that can be repartitioned.
Set Active: Sets the selected volume as Active (bootable). Only one partition per drive cay
be designated as Active.
Create an exact primary partition: (Available only if unpartitioned disk space exists)
Defines and creates a primary partition on the disk. You cannot create more than four (4)
primary partitions on a disk.
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Create extended partition: (Available only if unpartitioned disk space exists) Extends the
selected partition, then subdivide the extended partition into one or more logical drives.
Edit Policy: Launches the Partition Creation Policy Editor.
6.

On the Specify the Restoration Options page, select the appropriate volume restore options,
then click Next.
Set Partition Active: Configures the restored volume as the active partition in the system
(the drive the machine boots from).
Restore MBR: Restore the master boot record (MBR) as part of the volume restore job. The
master boot record is stored in the first sector of the first physical hard drive, and contains the
master boot program and partition table. The master boot program uses the partition table to
determine the active partition, then starts the boot program from the boot sector of the active
partition. When selected, you have the following MBR restore options:
Restore MBR from the image file: Restores the MBR from the backup image file.
Restore original Windows XP MBR: Restores the default MBR that ships with Windows
XP.
Restore disk signature: Restores the original hard drive physical disk signature. Windows
Server 2003, Windows 2000 Advanced Server, and Windows NT Server 4.0 Enterprise
Edition (SP3 and later) require disk signatures to use the hard drive.
Restore Disk Hidden Track: Restores the first 63 sectors of a drive. Some boot loader
applications require this for the system to boot.

7.

On the Wizard Summary page, review the details of the volume restore operation, then click
Finish.

You can view the progress of restore volume operation in the Backup Jobs tab.
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Chapter 9: Backup Image Tool
ShadowProtect provides the Backup Image Tool so you can manage existing backup image files, and
provides the following primary features:
Consolidate a point-in-time backup image (Full + Incremental images) into a new Full image.
Change the compression setting on an existing image.
Change the encryption setting on an existing image.
Split an backup image file into a Spanned Set where each file has a maximum file size. This is
useful for moving backup image files to CD or DVD.
Convert a backup image into a virtual machine format (VMDK or VHD).
You can access the Backup Image Tool from either Windows or the StorageCraft Recovery
Environment.
To use the Backup Image Tool
1. Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

2. In the Tools menu, click Backup Image Tool.
3. On the Source Image File page, browse to the location of the backup image files you want to
modify.

Specify Source Im age File

ShadowProtect displays the Full images stored in the specified location.
4. Select the Base Image File to work with, then click Next.
Note: If the backup image is encrypted you must provide the appropriate password.
5. In the Backup Image Dependencies page, select the Incremental image that represents the
point-in-time to consolidate with the Full image, then click Next.
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Select a point-in-tim e to consolidate into a new Full im age

Select a backup image file (left pane) to view its properties (right pane), including:
Originating machine: The operating system version, the machine name, MAC address
and the engine version of ShadowProtect used to create the image file.
Disk Information: Disk geometry, disk size and number of the first track sectors. You
can view the original disk layout in graphical form at the bottom of the screen.
Original Partition Information: Style, number, type, bootable option, starting offset and
length.
Image File Properties: Volume size, creation time, compression, password protection,
comment.
6. In the Destination Image File page, specify the required information, then click Next.
Select network
From the drop-down menu, select the Destination (see Section 6.2:
location or browse Destinations 41 ) where you want to store the destination image file, or
to a local path
Browse to the desired location.
Specify image
name

Specify a name for the destination image file.

Save As

Select the type of image file you want to create. Supported options include:
SPF: Create a new Full (Base) image file.
VHD: Create a Microsoft Virtual Hard Disk file compatible with Microsoft and
Hyper-V virtual environments.
VMDK: Create a Virtual Machine Disk file compatible with VMware virtual
enfironments.
ESX Server: Create an ESX server file compatible with VMware ESX virtual
environments.

7. In the Options page, specify the desired backup image file options, then click Next.
For information about each of these options, including the Advanced options, see Section
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.

8. In the Wizard Summary page, review the Backup Image Tool job summary, then click Finish.
Monitor the progress of the Backup job in the Backup Jobs tab (select the job, then click Details).
Review the results of previously executed jobs in the Backup History tab.
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Chapter 10: Remote Management
ShadowProtect provides two ways to remotely manage ShadowProtect Backup Agents installed on
remote servers and desktops (known as remote nodes), as long as these systems are accessible
through the local area network or a virtual private network (VPN). By connecting to a remote node
through one of these tools, you have full access to ShadowProtect features and functionality on the
remote node.
Remote Management with the Management View
Remote Management with the Network View

60

64

Note: You must have administrative rights to the remote node in order to manage it. However,
with the proper administrative rights, you can remotely manage both ShadowProtect Server Edition
and ShadowProtect Desktop Edition nodes using either the Management View or the Network View.

10.1 Remote Management with the Management Console
The Management View tab is designed specifically for ShadowProtect Server and ShadowProtect SBS
users that need to manage a larger number of remote ShadowProtect installations from a central
location.
Although the functionality is very similar to the Network View, the Management View organizes it in a
way to make it more friendly to administrators with many remote nodes to manage. You can open and
close the Management View by selecting Management View in the View menu (see Section 5.3.2:
Management View 35 ).
You can do the following from the Management View:
Installing the Backup Agent Remotely
Adding and Deleting Remote Nodes
Modifying Remote Node Properties

60

64
65

Connecting and Disconnecting Remote Nodes

65

Installing the Backup Agent Remotely
Using the Push Agent, Management View lets you remotely install the ShadowProtect Backup agent
so you can configure ShadowProtect operations on the remote system.
To remotely install the backup agent
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

In the View menu, click Management View to open the Management View.

3.

In the Management View, click Install.

21

).

This opens the Push Install Wizard so you can configure the push install.
4.

On the Push Wizard dialog box, provide the required information, then click Next.
System Name

The name of the system where you want to install the ShadowProtect
Backup agent. Select either Domain name or Host name according to the
type of system name you are providing, then type the system name in the
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field.
Note: If you leave the field blank, Push Install uses your current domain
or workgroup to locate a list of available systems.
Use Active Directory
Search

Instructs ShadowProtect to search Microsoft Active Directory for the
desired system.
To use this parameter, click options (at the bottom of the Push Install
dialog box when Use Active Directory search is selected) to refine the
Active Directory search characteristics.

Use Specified
Credentials

The authentication credentials that Push Install uses to gain access to the
remote system.
Note: If you do not provide credentials, Push Install uses your current
credentials to attempt to access the remote system.

Discover Services

Push Install attempts to identify existing ShadowProtect services running
on remote systems. When successful, it displays the information it
gathers about agent version.

Automatically activate Push Install automatically activates the Backup agent it installs.
installed agents
To use this parameter, click settings (at the bottom of the Push Install
dialog box when Automatically activate installed agents is selected) to
specify the Username and Serial # of the ShadowProtect license you want
to use on the remote system.
Reboot after install

Following a successful Backup agent install, ShadowProtect automatically
re-boots the remote system so the Backup agent is active.
To use this parameter, click settings (at the bottom of the Push Install
dialog box when Reboot after install is selected) to specify the details of
the reboot operation. You can instruct the remote system to reboot at a
specific date/time; specify a message to display before rebooting; and
specify a delay before the reboot occurs (in seconds).

5.

(Conditional) On the Computers Overview page, select the systems where you want to install
the Backup agent, then click Next.
If you didn't specify a system name, you can select the systems where you want to install the
Backup agent here.

6.

On the Install Overview page, wait until the install finishes, then click Next.

7.

(Optional) On the Post Install Overview page, specify a Group name for each system where you
installed the Backup agent, then click Next.
Click in the Group name field, then type of select the group where you want to add this
system. For more information about Groups, see Modifying Remote Node Properties 62 .

8.

On the Summary page, click Finish.
The newly installed remote nodes appear in the Management View node list.

Adding and Deleting Remote Nodes
Before managing a remote node, you must add it to your Management View.
© 2010 StorageCraft Technology Corporation
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To add a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

If the Management View is not visible, select Management View from the View menu.

3.

In the Management View, click Add

4.

In the Server Details dialog box, specify the appropriate connection information for the remote
node.

21

).

.

For information about remote node properties, see Modifying Remote Node Properties

65

.

You can now connect to the remote node to manage ShadowProtect.
To delete a remote node
1.

In the Management View, select the remote node in the node list.

2.

Click Delete

.

Deleting a remote node does not delete ShadowProtect or any of its configurations from the
remote node, or remove the remote node from the Management View of any other system that
might be configured to remotely manage that node.

Note: You cannot delete the local node from the Management View.

Modifying Remote Node Properties
The properties table displays the properties of the currently selected remote node. You can edit
remote node properties as long as the remote node is not connected.
To modify the properties of a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

If the Management View is not visible, select Management View from the View menu.

3.

In the node list, select a remote node to modify.
If the Server Properties pane is not visible, click Properties

4.

21

).

.

In the Server properties pane, modify the remote node properties as needed.
Select a field to make it active. You can also use the Tab key to move from field to field.
Remote Node properties include the following:
Server Name

A remote node name used to identify it in the node list.

Server Address

The IP address or machine name of the remote node. To browse the network
for a particular system so you can find the IP address, click Browse
.

Group

The group that you want to associate with the remote node. You can create
groups help organize remote nodes and make management easier.

Server Description A description of the remote node. This is for your information only.
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Status

(Informational) The remote node status (Connected or Disconnected).

Domain Name

The domain name used to access the remote node.

User Name

A user name with Administrator rights to the remote node.

Password

The user name's associated password.

Agent Version

(Informational) The version of the Backup Agent installed on the remote node.

Last Connected

(Informational) The date and time you last connected to the remote node.

Connecting and Disconnecting Remote Nodes
To connect to a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

If the Management View is not visible, select Management View from the View menu.
2.

In the Management View, select the remote node in the node list.

3.

Click Connect

.

You can be connected to only one node at a time. If you connect to another remote node,
ShadowProtect automatically disconnects you from the previously connected node.
Note:You must add a remote node in order to connect to it (see Adding and Deleting
Remote Nodes 64 ).
To disconnect a remote node
1.

In the Management View, select the remote node in the node list.

2.

Click Disconnect

.

Disconnecting a remote node does not stop the ShadowProtect Backup Agent or affect any of
ShadowProtect operations on the remote node.
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10.2 Remote Management with the Network View
When open, the Network View appears as a right panel in the ShadowProtect Console. You can open
and close the Network View by selecting Network View in the View menu (see Section 5.4: Network
View 36 ).
You can do the following from the Network View:
Adding and Deleting Remote Nodes
Modifying Remote Node Properties

64
65

Connecting and Disconnecting Remote Nodes
Exporting and Importing Node Settings

65

66

Adding and Deleting Remote Nodes
Before managing a remote node, you must add it to your Network View.
To add a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

If the Network View is not visible, select Network View from the View menu.
2.

In the Network View, click Add

.

This creates a new node in the Network View named New Node 1 and opens a Server
Properties pane where you can configure the remote node.
3.

In the Server Properties pane, specify the appropriate connection information for the remote
node.
For information about remote node properties, see Modifying Remote Node Properties

65

.

You can now connect to the remote node and manage ShadowProtect.
To delete a remote node
1.

In the Network View, select the remote node in the node list.

2.

Click Delete

.

Deleting a remote node does not delete ShadowProtect or any of its configurations from the
remote node, or remove the remote node from the Network View of any other system that
might be configured to remotely manage that node.

Note: You cannot delete the local node from the Network View.
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Modifying Remote Node Properties
The properties table displays the properties of the currently selected remote node. You can edit
remote node properties as long as the remote node is not connected.
To modify the properties of a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

If the Network View is not visible, select Network View from the View menu.
2.

In the node list, select a remote node to modify.
If the Server Properties pane is not visible, click Properties

3.

.

In the Server properties pane, modify the remote node properties as needed.
Select a field to make it active. You can also use the Tab key to move from field to field.
Remote Node properties include the following:
Server Name

A remote node name used to identify it in the node list.

Server Address

The IP address or machine name of the remote node. To browse the network
for a particular system so you can find the IP address, click Browse
.

Group

The group that you want to associate with the remote node. You can create
groups help organize remote nodes and make management easier.

Server Description A description of the remote node. This is for your information only.
Status

(Informational) The remote node status (Connected or Disconnected).

Domain Name

The domain name used to access the remote node.

User Name

A user name with Administrator rights to the remote node.

Password

The user name's associated password.

Agent Version

(Informational) The version of the Backup Agent installed on the remote node.

Last Connected

(Informational) The date and time you last connected to the remote node.

Connecting and Disconnecting Remote Nodes
To connect to a remote node
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

If the Network View is not visible, select Network View from the View menu.
2.

In the Network View, select the remote node in the node list.

3.

Click Connect

.

You can only be connected to a single node at a time, so if you connect to another remote
node, ShadowProtect automatically disconnects you from the previously connected remote
node.
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Note:You must add a remote node in order to connect to it (see Adding and Deleting Remote
Nodes 64 ).
To disconnect a remote node
1.

In the Network View, select the remote node in the node list.

2.

Click Disconnect

.

Disconnecting a remote node does not stop the ShadowProtect Backup Agent or affect any of
ShadowProtect operations on the remote node.

Exporting and Importing Node Settings
ShadowProtect lets you transfer remote node configurations from one ShadowProtect Console to
another.
To export remote node configurations
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

21

).

If the Network View is not visible, select Network View from the View menu.
2.

In the Network View, click Export nodes

3.

Specify the name for the XML file that contains the exported remote node configurations, then
click Save.

.

To import remote node configurations
1.

In the Network View, click Import nodes

2.

Browse to the XML file that contains the previously exported remote node configurations, then
click Open.

.

© 2010 StorageCraft Technology Corporation

Using VirtualBoot

67

Chapter 11: Using VirtualBoot
VirtualBoot lets ShadowProtect users boot a backup image in a Virtual Machine (VM) environment.
VirtualBoot leverages the open source Oracle VirtualBox software so you can quickly boot a backup
image without performing a time-consuming restore operation, and without converting backup image
files to a different format.
VirtualBoot provides tremendous value in the following situations:
System Fail-over: When you're dealing with Terabytes of storage, restoring a failed system can take
days. However, VirtualBoot lets you quickly recreate your failed system in a VM while you rebuild the
failed system. Users have full access to the system during this time, with only a brief downtime to cutover to the new system once it is ready. Downtime drops from days to just minutes.
Backup Test: Disaster recovery is all about having system data stored in a way that is readily
accessible should it be needed. But can you be confident that your stored data is valid? VirtualBoot
lets you mount any backup image in a VM so you can test it to make sure a restored system would
function properly. In just minutes you can feel confident that your backup images are ready for use
when needed.
Application-specific Data: While backing up system data is a critical operation, sometimes the data
files alone aren't useful without their associated applications. VirtualBoot lets you mount an entire
system, both applications and data, in a VM where you have access to data from its associated
application.
For information about VirtualBoot usage scenarios, see Section 3.3: VirtualBoot Scenarios

11

.

This section includes the following topics:
VirtualBoot Requirements
Limitations

67

68

Creating a VM

68

Configuring a VM

73

11.1 VirtualBoot Requirements
VirtualBoot requires you to install the following software before using it:

Software Requirements
ShadowProtect 4.x or later: VirtualBoot supports backup image files created by any version of
ShadowProtect, but you must have ShadowProtect 4.x or later to run the application.
ShadowProtect 4.x includes VirtualBoot as a core component. For more information about
ShadowProtect, see the StorageCraft ShadowProtect User Guide.
Note: Although VirtualBoot can generate a VM from backup image files created with any
version of ShadowProtect, StorageCraft recommends using VirtualBoot with backup image
files created by ShadowProtect 3.3 and later to get full access to the benefits of
VirtualBoot.
VirtualBox 3.1.x: VirtualBox is an open source VM environment. VirtualBoot provides native
support for ShadowProtect files in a VirtualBox VM. For information about VirtualBox, and to
download the software, visit www.virtualbox.org. VirtualBox is free for personal, education, and
© 2010 StorageCraft Technology Corporation

68

ShadowProtect User Guide

evaluation use.

Hardware Requirements
VirtualBoot hardware requirements are driven primarily by the hardware requirements necessary to run
VirtualBox (see VirtualBox End-User Documentation).
Processor: Reasonably powerful x86 processor (either Intel or AMD).
Memory: At least 1GB.
Hard Drive: Several GB at least. This is dependent upon the Operating System you want to load in
the VM.
Guest OS: VirtualBoot supports backup image files that contain backups of the following operating
systems (This is the OS that runs in the VM):
Windows 2000
Windows XP (32- and 64-bit)
Windows 2003 (32- and 64-bit)
Windows Vista (32- and 64-bit)
Windows 2008 (32- and 64-bit)
Windows 2008 R2 (32- and 64-bit)
Windows 7 (32- and 64-bit)

11.2 Limitations
This release of VirtualBoot has the following limitations:
VirtualBoot supports boot volumes up to 2TB. However, VirtualBoot supports data volumes (nonbootable) of any size.
No support for LBD disk volumes (sector size > 512bytes).
If the VM Host crashes while running a VM created from a backup image file, you must create a
new VM using the latest Incremental backup image file.This is because VirtualBox stores all VM
writes in a write buffer file (.spwb). These files are very efficient, but not crash-proof, so a restart
of the VM loses all data in the write buffer file. Creating a new VM limits the data loss to only that
since the last Incremental backup.

11.3 Creating a VM
Before using VirtualBoot to create a VM, review the Requirements

67

.

To create a virtual machine
1.

Start VirtualBoot, then click Next on the VirtualBoot Wizard welcome page.
There are three ways to start VirtualBoot:
Executable: In Windows, select Start > ShadowProtect > VIrtualBoot.
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Command Line: From a Windows command prompt, type VirtualBoot <backup image
file>, where <backup image file> is the name, including full path, of the ShadowProtect
backup image file that you want to use to create a VM. For example:
VirtualBoot e:\backups\C_VOL-b005.spi
Right-Click Menu: In Windows Explorer, right-click the ShadowProtect backup image file that
you want to use to create a VM, then select VirtualBoot.
2.

In the Backup Image List page, provide the required information, then click Next.
If you start VirtualBoot using the command line or right-click menu option, VirtualBoot populates
the Backup Image list with all files that are part of the backup chain for the specified backup
image file.
Add Image File

Lets you add a backup image file to the VM.
Backup images created with ShadowProtect 3.3 or later contain metadata
that lets you include multiple drives in the same VM.
If the selected backup image file is encrypted, you must provide a valid
password to access it.

Remove Image File

Lets you remove a backup image file from the VM.

Specify Boot Volume Lets you designate the boot volume in the VM. Typically, VirtualBoot

detects this automatically, but if you include multiple bootable volumes in
the VM, you can select the volume that VirtualBoot designates as the
boot volume.

Note: If you specified a backup image file when starting VirtualBoot, this page lists the
related backup image file information.
3.

Select the backup image file (Full or Incremental) that you want to load in the VM, then click Next
.
The Backup Image List displays all backup image files associated with the selected backup
image chain.

4.

In the Options page, provide the required information, then click Next.
Specify the operating system
for the new virtual machine

From the dropdown menu, select the Windows OS contained in
the boot volume of the backup image file.

Automatically create the new
virtual machine

Select this option to have VirtualBoot automatically create the
VM as part of the configuration process. If you do not select this
option, you must manually configure the VM in VirtualBox.
In either case, VirtualBoot creates the XSP files that VirtualBox
uses to define the virtual disk drives in the VM.
Note: VirtualBoot ALWAYS places the boot volume in the
Disk_0 XSP file.
For more information, see Manually Configuring a VM
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Automatically start the new
virtual machine

Select this option to launch VirtualBox automatically after the
VM is complete and load it for use.

Specify the name of the new
virtual machine

Specify a name for the VM. By default, VirtualBoot creates a
name based on the machine name.

Specify the amount of memory Specify the amount of memory, in MB, that VirtualBox should
to allocate to the new virtual allocate for use by the VM when it loads.
machine
Specify the VM network
adapter type

Select whether to include a network adapter in the VM.
Supported options include:
NAT PRO/1000 MT Desktop: Adds a generic network
adapter to the VM that uses Network Address Translation
(NAT).
No Network Adapter: Excludes a network adapter from the
VM.

5.

(Optional) On the Options page, click Advanced to open the Advanced Options dialog box.
The Advanced Options dialog box provides the following options:
Import only one volume per
hard disk drive within the
virtual machine

Instructs VirtualBoot to include only one volume per VirtualBox
XSP file. By default, VirtualBoot assigns four volumes per XSP
file.
Note: VirtualBoot ALWAYS places the boot volume in the
Disk_0 XSP file.

Deactivate Windows within the Deactivates Windows on the VM's system volume. Because
virtual machine
Microsoft licensing limits the number of reactivations, this

options lets you use the activation grace period to accomplish
your purposes with the VM.
Note: If the host hardware where you start the VM is
sufficiently different, Windows might deactivate automatically.

6.

Store write buffers in a
different directory than the
image files

Lets you specify a location to store the write buffers used when
creating the VM. By default, VirtualBoot stores write buffers in
the same location as the backup image files used to create the
VM.

Override personality used to
configure the virtual machine
OS volume

For use only by StorageCraft technical support.

On the Wizard Summary page, click Finish.
VirtualBoot generates the files necessary to support the new VM and, if specified in the VM
configuration, creates the VM and launches it for use.
Note: For information about manually creating a VM in VirtualBox, see Creating a VM
Manually 71 .
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(Conditional) If you do not start the VM as part of the VirtualBoot creation process, you must start
the VM manually from VirtualBox.
a. Launch VirtualBox.
b. In the left-side VM list, select the VM, then click Start..

8.

Continue with Configuring a VM

73

.

Creating a VM Manually
If you elected not to have VirtualBoot start the VM for you as part of the VM creation process (see
Step 4 in Creating a VM 68 ), you must manually create the VM in VirtualBox.
Note: The following task is based on VirtualBox v 3.1.4. Task details might vary slightly with
different versions of VirtualBox.

The VirtualBox UI

To manually create a virtual machine
1.

Launch VirtualBox, then click New.

2.

On the Create New Virtual Machine Wizard, click Next.

3.

On the VM Name and OS Type page, specify the required information, then click Next.
Name
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4.

Operating System

The model of operating system used in the VM. VirtualBoot supports only
Microsoft Windows.

Version

The specific Windows operating system used in the VM.

On the Memory page, specify the amount of system memory (RAM) to allocate for use by the
VM.
More memory makes the VM faster and more efficient. StorageCraft recommends at least
512MB.

5.

On the Virtual Hard Disk page, select Use existing hard disk, then select the bootable virtual
disk created by VirtualBoot.
The VirtualBoot virtual hard disk files have an XSP extension. VirtualBoot ALWAYS places the
boot volume in the Disk_0 XSP file.

6.

On the Summary page, click Finish.
VirtualBox creates the VM.

7.

Once created, you can start the VM manually from VirtualBox.
a. Select the VM In the left-side list.
b. Click Start..

8.

Continue with Configuring a VM

73

.

A new VirtualBox VM
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11.4 Configuring a VM
Once you have started a VM, you must configure it for use, much like you might configure a new
Windows installation. This process involves the following tasks:
Configuring Drivers

74

Installing Guest Additions

74

Configuring a Network Driver

73

Continuing Continuous Incrementals

74

Note: When working with a VM, you must be able to switch keyboard/mouse focus between the
VM and your system environment. To switch focus to the VM, simply click the mouse in the VM
window. To switch focus out of the VM, press the right Ctrl button.

Configuring a Network Adapter
If you choose not have VirtualBoot create a network adapter (NIC) in the VM, you can add it after the
fact. For the following reasons, this might be a good idea if you want to boot a backup image while the
source system is still operational:
Two systems on the network with the same network ID can cause routing problems, particularly at
the Domain controllers.
Both the VM and the source system might save Incremental backup images to the same network
location. This can threaten the integrity of your backup image chain.
Keeping the VM off the network lets you resolve these types of issues before they cause any
problems. For example, once the VM loads you can pause ShadowProtect backup operations in the
VM, or change the backup image file destination to a local storage location so it does not conflict with
the source system.
To add network support to the VM
1.

Launch VirtualBox.

2.

On the VirtualBox main page, select the VM where you want to add a NIC, then click Settings.
The VM must be powered off to modify the VM settings.

3.

On the Settings page, select Network in the left-side navigation.

4.

Select the Adapter 1 tab, then select Enable Network Adapter.

5.

In the Attached To field, select how you want the virtual NIC to communicate with your host.
By default, VirtualBox uses Network Address Translation (NAT), but it supports other
connection options. For more information, see the VirtualBox documentation.

6.

Click Advanced, then select the virtual adapter type to use in the VM.
In testing, the "Intel Pro/1000 MT Desktop" appears to be a good generic driver for the
VirtualBoot environment.

7.

Click OK to modify the network adapter settings.
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Configuring Drivers
After starting a VM for the first time, you must allow Windows to detect and configure drivers for the
VM environment.
To configure a virtual machine for use
1.

In the VM window, click Machine > Insert Ctrl-Alt-Delete to launch the Windows login, then log
in to the VM.
Click in the VM window to transfer mouse and keyboard control to the VM.

2.

Allow Windows to identify hardware and install drivers in the VM.
Windows goes through it's initial boot sequence, identifying hardware and attempting to load
drivers for those devices. This process is similar to performing a Hardware Independent Restore
(HIR) in ShadowProtect. Follow the on-screen prompts and allow Windows to reboot as needed
to load the necessary drivers.

3.

After rebooting, log in to the VM.
Note: Because of hardware changes detected by Windows as part of the transition to the VM
environment, you will likely be prompted to reactivate Windows when you log in to the VM.
However, you typically have a three-day grace period for doing this. Because Microsoft restricts
the number of hardware reactivations for each Windows license, you might want to leave
Windows deactivated if you can get the production system ready to restore within the three day
grace period. If this is not possible, activate Windows in the VM using the standard Microsoft
activation process, and your Windows VM is licensed for as long as you need it.

Installing Guest Additions
After Windows has installed drivers for the VM environment, you can install VirtualBox additions that
provide enhanced interaction with, and control over, the VM environment.
To install VirtualBox guest additions
1. From the VM menu bar, select Devices > Install Guest Additions.
This loads a virtual CD into the VM that has extra software designed to make the VM run
quickly and smoothly. If the CD does not auto-run, browse the CD drive in the VM and execute
one of the following:
VBoxWindowsAdditions-x86.exe: 32-bit Windows VM.
VBoxWindowsAdditions-amd64.exe: 64-bit Windows VM.
2. Follow the directions in the Guest Additions Wizard, then reboot the VM.
3. Log in to the VM.

Continuing Incrementals Backups
To facilitate a true fail-over option and Head Start Restore (HSR), you must be able to continue the
incremental backup process from within the VM. You must have a network adapter configured in the
© 2010 StorageCraft Technology Corporation

Using VirtualBoot

VM to continue Incremental backups. For more information, see Configuring a Network Adapter

75

73

.

Note: To prevent performance problems in the VM, all incremental images should be created
using the fast (VDiff) incremental option rather than a diff/comparison-based (DiffGen) method.
Make sure your backup job uses VDiff incrementals before starting it in your VM environment.
To continue incremental backups in the VM
1.

Launch VirtualBox, then start the appropriate VM.

2.

Once the VM loads, log in, then start ShadowProtect.

3.

In ShadowProtect, select the Destinations tab.

4.

In the Destinations tab, select the destination object used to store the VM's source backup image
files, then click Edit.
Warning: Do not delete the destination object or you will break the backup image chain.
Rather, modify the destination object as needed to point to the current location of the backup
image files used to create the VM.

5.

In the Destination dialog box, modify the Destination Path to point to the location of the backup
image files used to create the VM, then click OK.
You might need to modify the network credentials (Domain, User, Password) in the destination
object to access the backup image files in their new location. If you have problems with name
resolution in the VM environment, try using the IP address of the host machine rather than its
Host name.

6.

In the ShadowProtect main page, select the Backups tab.

7.

Select the appropriate backup job, then click Execute.
ShadowProtect starts an incremental backup job. The naming of incremental backup files in the
VM starts where the last Incremental image file used to create the VirtualBoot VM left off. The new
incremental image file depends on the Incremental image file chain used to create the VM. This
maintains a single backup image chain and makes it possible to provide Head Start Restore
(HSR) capabilities.
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Chapter 12: Other Operations
ShadowProtect provides the following features to help you manage and maintain your backup
environment:
Verifying Backup Image Files
Email Notification
Log Files

76
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12.1 Verifying Backup Image Files
It is important to verify the quality and integrity of backup images on a routine basis to ensure that a
backup image is ready should you need it.
One way to do this is to mount a backup image and browse the files and folders. If you can do this
successfully, you know the backup image is healthy. However, you can also use the Verify Image tool
to test the integrity of a specific backup image.
To test a backup image with the Verify Image tool
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

Open the Verify Image Wizard by doing one of the following:
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In the Tools menu, click Verify Image.
In the Menu bar, select Tasks > Verify Image.
3.

On the Source Image File page, select the Image Set to verify, then click Next.
In the drop-down menu, select the Destination (see Section 6.2: Destinations 41 ) that
contains the backup Image Set to restore, or click Browse to locate the desired backup
Image Set. The Specify Image Names field displays the Image Sets available at the selected
Destination or path.
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Select an im age set to verify

Note: To verify a backup Image Set stored on a network share, you must have the proper
network credentials.
4.

On the Backup Image Dependencies page, select the point-in-time to restore, then click Next.

Select a specific point-in-tim e to verify

This page displays all Incremental backup image files associated with the selected Image
Set. Select a specific backup image file to view the following image file properties:
Image File Properties: Volume size, creation time, compression, password protection,
comment.
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Original Partition Information: Style, number, type, bootable option, starting offset and
length.
Disk Information: Disk geometry, disk size and number of the first track sectors. You can
also view the disk layout graphically at the bottom of the screen. This represents what the
disk looked like at the time of backup.
Originating machine: Operating system version, the machine name, MAC address and
the ShadowProtect engine version used to create the image file.
5.

On the Specify the Verify Options page, select what you want to verify, then click Next.
Verify only selected image: The Verify Image tool checks only the selected backup image
file.
Verify selected image and all dependent files: Verifies the selected backup image file
and all files that it depends on. This verifies the integrity of the full point-in-time backup. If you
select this option, specify the order to verify the files (Newest to Oldest or Oldest to
Newest).

6.

On the Wizard Summary page, review the details of the verify operation, then click Finish.

You can view the progress of verify operation in the Backup Jobs tab.

12.2 Configuring Email Notifications
ShadowProtect can be configured to send Email notifications on the success or failure of a backup
job. The Email notification includes the following information:
Email Subject: Indicates that this notification is for a successful or unsuccessful back up job.
Email Body: Contains the following information about the backup job.
Start time
Finish time
Source volume
Destination path
To configure email notifications
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

In the Menu bar, select Options > Agent Options.

3.

On the Agent Options page, provide the details of the Email configuration, then click OK.
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).

SMTP Server Name or The host name or IP address of the outgoing SMTP server to use when
IP Address
sending Email notifications (for example smtp@mycorp.com).
SMTP Port

(default: 25) The port used by the SMTP service.

SMTP Login User
Name

The username ShadowProtect uses to access the SMTP server.

SMTP Login Password The password associated with the SMTP user name.
SMTP Authentication
Method

The authentication method used by the SMTP server. Select the
appropriate authentication method from the drop-down list.

Use SSL

(Default: Off) Indicates if you want to use a secure connection to
communicate with the SMTP server.
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Email From Address

The Email address that appears in Email message's From field.

Email To Addresses

A semi-colon separated list of Email addresses that you want to receive
the notification. For example, john@mycorp.com;bill@mycorp.com.

Character Encoding

The character-encoding to use with the Email subject and body. Select the
appropriate value from the drop-down list.

Custom Subject Suffix (Optional) A text string that appears the Email Subject field. Use /r for
carriage return, /n for new line, and /t for tab characters.

4.

Custom Body Prefix

(Optional) A text string that appears in the Email Message field. Use /r for
carriage return, /n for new line, and /t for tab characters.

Send Email on
Success

(Default: Off) Set to On to send Emails upon the successful completion of
a ShadowProtect job.

Send Email on Failure

(Default: Off) Set to On to send Emails upon the failure of a
ShadowProtect job.

(Optional) Click Test Email to send a test message and confirm that the Email configuration is
working properly.

12.3 Log Files
ShadowProtect creates a log file for each backup job. This log file provides information about the
backup job results, including the reason for failure, if any. You can view the log for any backup job in
the Backup History tab (see Section 5.3.6: Backup History Tab 34 ).
Each log entry provides information about the related backup job: Start Time, End Time, Type (Full or
Incremental), Source, Destination and Status. Backup jobs that finished successfully have a status of
“Completed.” ShadowProtect marks jobs that do not complete successfully with a Warning icon
.
These jobs have a status other than “Completed,” such as “Execution Failed” or “Aborted.” It is
important to review these entries and determine why the job failed.
The Job Log provides information about the events that occurred during that job: Timing (when the
event occurred), Module, Code, and Message. Backup jobs that finished successfully have a status of
“Completed.” ShadowProtect marks events that do not complete successfully with Failed icon

.

12.4 Creating Key Files
Key Files provide an alternative mechanism for protecting backup images. Key Files let you delegate
the creation and storage of backup image files without losing control of the passwords used to protect
your backup image files.
ShadowProtect includes the KeyFileMaker tool for generating Key Files. KeyFileMaker is provided on
the ShadowProtect CD, but is not installed by default.
Note: When using a Continuous Incrementals schedule (see Step 5 in Chapter 6: Creating
Backup Image Files 38 ), ShadowProtect automatically creates a new Key File each time it generates
a new Full image. ImageManager uses the Key File when collapsing Incremental images. For more
information about ImageManager, see the ShadowProtect IimageManager User Guide.
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To install KeyFileMaker
1.

Insert the ShadowProtect CD into the system's CD drive.

2.

Browse to the \Installers folder, then execute KEYFILEMAKERSETUP.exe.

3.

Follow the steps in the Installation Wizard to install the KeyFileMaker software.

Once installed, you can access KeyFileMaker in Windows by selecting Start > Programs >
ShadowProtect > ShadowProtect KeyFileMaker.

Shadow Protect KeyFileMaker

To create a key file
1.

Launch KeyFileMaker (Start > Programs > ShadowProtect > ShadowProtect
KeyFileMaker).

2.

In the KeyFileMaker dialog box, provide the following information, then click Create Key File.
Key files have a .spk file extension.
Set Password /
Confirm Passord

Specify the password to store in the Key File.

Save Key File As

Specify the name and location for the Key File. You must save the Key File in
the same folder as the backup image files that rely on it.

Key File
Association

Specify the backup Image Set that you want to associate with the Key File.
Generic Key File: The key file is not associated with any Image Set. You can
use a generic key file if all backup image files in a given folder are part of the
same Image Set.
Key File associated with a GUID: The File Set GUID (Globally Unique ID) of
the Image Set that you want to associate with this Key File.
Key File associated with a backup image file: The full file name, including
path, to a backup image file from the Image Set that you want to associate
with this Key File.
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All backup image files in an Image Set share the same File Set GUID. You can
view a backup image file's File Set GUID in the Image File Mount Wizard:
a. In Windows Explorer, double-click the backup image file.
b. On the Image File Name page, open the File Dependency Properties
property group.

12.5 Changing Partiton Creation Policy
The Partition Creation Policy Editor lets you modify basic disk geometry settings used to create a new
partition. You can access the Partition Creation Policy Editor from the Disk Map tab (see Section
5.3.3: Disk Map Tab 30 ) action menu (right-click menu).

The Partition Creation Policy dialog box

To modify partition creation settings
1.

Start the ShadowProtect Console (see Section 4.3: Starting ShadowProtect

2.

On the Center panel, select the Disk Map tab.

3.

Right-click the desired partition, then select Edit Policy.

4.

In the Partition Creation Policy Editor, modify the partition creation settings as desired, then
click Set Active.
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To modify a particular setting, click in the appropriate field, then type the desired value, or
select it from the drop-down list (if available).
Layout Type
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Partition Start
Alignment

(Default: Track) Identifies the partition starting point, which typically
occurs at a specific disk boundary. Supported options include:
Cylinder, Track, and Sector.

Partition End
Alignment

(Default: Sector) Identifies the partition end point. Supported options
include: Cylinder, Track, and Sector.

Offset from Disk Start Specifies an offset from the start of the disk where you want the

partition to begin. This should be a Whole number.
Disk Start Offset
Units

(Default: Sector) Specifies the units to use with the specified offset.
Supported options include: Cylinder, Track, Sector, Byte.

12.6 Creating a Recovery CD
StorageCraft provides an ISO image file that you can use to create a bootable Recovery Environment
disk. For more information about using the StorageCraft Recovery Environment, see the StorageCraft
Recovery Environment User Guide.
To create a Recovery Environment disk
1.

If necessary, download the Recovery Environment ISO image file.
a. Open a Web browser to the StorageCraft ISO Download Web page.
b. In the Serial Number field, specify the product serial number you received when you
purchased ShadowProtect, then click Submit.
c. Save the Recovery Environment ISO image (ShadowProtect_RE_4.0.0.iso) to a local
drive.

2.

Insert a blank CD/DVD/Blu-Ray in your system's optical drive.

3.

From Windows, select Start > ShadowProtect > ISO Tool.

4.

Browse to and select the ShadowProtect ISO file, then click Burn the Disk.
Select Overwrite any existing data... if you want to replace existing data on the disk.

5.

When ISO Tool finishes transferring the ISO image, click Close.
The ISO transfer can take several minutes to complete.
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Chapter 13: Best Practices
Turn off disk defrag software if using incremental backups. When you take an incremental
backup, you are writing a file of only the sectors which have changed since the last full or
incremental backup image was taken. If you run disk defrag software, you will be changing the
sectors on the disk and cause the time and size of the incremental backup image to greatly
increase. If you want to run disk defrag software, it is recommended that you do it before you run
a Full backup image and then do not run or schedule the disk defrag software to run while
ShadowProtect is scheduled to take Incremental backup images.
Test the StorageCraft Recovery Environment. Make sure the ShadowProtect CD lets you boot
your system and gain access to both any local drives and network devices that you might need.
Monitor disk space usage where images are stored. Make sure your backup image file storage
location has sufficient disk space for new backup image files, or backup jobs will fail.
Monitor the ShadowProtect log files. Routinely examine the ShadowProtect log files. The log files
will provide status of backup jobs, letting you know the backup jobs were completed successfully
or if the backup jobs failed. If the backup job failed, the log files will provide details of the failure
allowing you to take action to correct the situation.
Use password encryption to protect backup image files. Since ShadowProtect backup images
include all the contents of the disk drive, use password encryption to help protect data security.
Include multiple volumes in your backup job. If you have databases or applications that span
volumes, include all relevant volumes in the backup image. ShadowProtect snapshots can operate
simultaneously on multiple volumes, thereby ensuring cross-volume consistency.
Periodically save backup image files on a removable hard drive. CD, DVD, and Blue-Ray
storage lets you easily store backup image files at an off-site location. This helps ensure available
backup images in the case of a disaster.
Use the Backup Image Tool to manage backup images. You can consolidate backup images,
split backup images for CD or DVD storage, and apply new password encryption to existing
backup image files in the event passwords are compromised (see Chapter 9: Backup Image Tool
57 ).
Use Email notification. Automatic Emails keep you informed of the operation of your ShadowProtect
backup jobs so you can quickly identify and resolve problems that might arise (see Configuring
Email Notifications 78 ).
Use a retention policy that maximizes point-in-time histories. Review the options available in the
ShadowProtect for retaining point-in-time histories, including using Differential images for second
and subsequent Full images (see "Retention" in Section 6.3.5: Advanced Options 45 ).
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Chapter 14: Retention Policy Configurations
ShadowProtect employs a unique method for maximizing point-in-time backup images while
minimizing storage consumption that results in the ability to store more point-in-time histories in
substantially less storage space. The following two tables present four common retention policies for a
scheduled backup job, and the resulting performance of each. For more information about creating
scheduled backup jobs and retention policies, see Chapter 6: Creating Backup Image Files 38 .

Com parison of various retention policies
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Chapter 15: Product Support
Technical support for StorageCraft products is available beginning with the release of the product and
ending six months after the release of the next major version of the product or after StorageCraft
discontinues the product line.

Complimentary Technical Support
StorageCraft complimentary technical support consists of self-help support tools that are available
at www.storagecraft.com/support.html (in English only), and an easy-to-use, powerful knowledge
base that helps you find answers to the most frequently asked product questions, as well as “howto” procedures and technical information about all StorageCraft products.

E-Mail Support
Requests for e-mail support in North America are processed 8:00 am to 5:00 pm MST, Monday
through Friday. To obtain e-mail technical support for specific technical questions or issues, fill out
the form at www.storagecraft.com/supportform.html. Please provide as much detail as possible to
help the technical support engineers understand and diagnose the issue.
In order to ensure efficient service, please provide at a minimum the following information:
Product name and version number
Detailed problem description, error code, log file description, etc.
Hardware and software configuration, operating system version, service pack number, etc.

Telephone Support
StorageCraft support engineers are available Monday through Friday 9:00 A.M. to 5:30 P.M. (MST),
except for business holidays. To reach the StorageCraft technical support team, please call: (801)
545-4710. Telephone support is available to all customers with a current maintenance plan or
customers who have purchased technical support from the StorageCraft Web store. If you are not
immediately connected to a support engineer, leave a message and the next available support
engineer will return your call.
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Chapter 16: Glossary
Backup: The activity of copying files, volumes, and databases to preserve them in case of equipment
failure or other catastrophe. An important part of a disaster recovery strategy, backup is often
neglected, particularly for personal computer users.
Backup Image File: Files that contain the contents of a backup activity, Backup Image Files let you
restore the contents of a computer system to a specific point-in-time.
Bare Metal Recovery: The complete restoration of computer data after a catastrophic failure,
including the operating system, file system, partitions, volumes and data, from a complete backup
image.
Base Image File: Backup files that contain a copy of all used sectors on a disk drive. This image file
contains all data on the computer, including the operating system, applications, and data.
Basic Disk: A physical disk drive that can be accessed by MS-DOS* and all Windows* operating
systems. Basic disks can contain up to four primary partitions, or three primary partitions and an
extended partition with multiple logical drives.
Cold Backup: A backup taken from the Recovery Environment, rather than when the computer's
operating system is loaded.
Continuous Incrementals: A backup scheduling model for ShadowProtect that lets you create a
base backup file, then create additional incremental backup files that include only changes that
occurred since the last backup.
Compression: A technology that reduces the size of a file. Compression lets you save time,
bandwidth and storage space.
Differential Image File: Backup files containing the hard drive sectors that have changed since the
Base Image File was created. Differential image files take about the same time to create as Base
Image Files, but they are smaller. When restoring a drive (or files and folders), you must use the Base
Image File with the appropriate Differential Image File to restore the computer to a specific point-intime.
Disaster Recovery: The ability to recover from the complete loss of a computer, whether due to
natural disaster or malicious intent. Typical disaster recovery strategies include replication and
backup/restore.
Disk Device: A locally accessible disk drive, including locally attached USB or FireWire disk drives,
and network drives such as SAN, NAS, iSCSI, SCSI, USB or FireWire.
Driver: A program that interacts with a particular device or software. The driver provides a common
interface to the device, or software, that makes it accessible to other computer systems and the user.
Drive Letter: See Mount as Drive Letter.
Dynamic Disk: A physical disk that provides features that basic disks do not (see Basic Disk), such
as support for volumes spanning multiple disks. Dynamic disks use a hidden database to track
information about dynamic volumes on the disk and other dynamic disks in the computer.
Encryption: A procedure that renders the contents of a file unintelligible to anyone that cannot present
the appropriate decryption key.
ExactState™ Imaging: The ability to create a backup image at a point where the computer is in the
best state for creating a backup (for example, no open files).
Full Image File – See Base Image File.
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Hard Drive: An electromagnetic storage device, also referred to as a “disk drive,” “hard drive,” or “hard
disk drive” that stores and provides access to data on a computer.
Head Start Restore (HSR): The ability to begin the restoration of a large backup image chain while
ShadowProtect continues to add Incremental backup image files to the same image chain. This
reduces the time necessary to restore a large volume from days or weeks, to minutes or just a few
hours.
Hot Backup: A backup image taken when ShadowProtect is loaded on the computer's standard
operating system. A hot backup requires the use of a snapshot filter driver (see Snapshot).
Hot Restore: The restoration of a backup image while the computer or server remains up and running.
You cannot perform a hot restore of a system volume.
Image or Image File: See Back up Image File.
Image Set: The combination of a Full image and all additional Incremental images necessary to
restore a computer to a given point-in-time.
Incremental Image File: Backup files containing the sectors that have changed since the last
Incremental backup was taken. Incremental Images are fast to create and smaller than either Base
Image Files or Differential Image Files. When restoring a drive (or files and folders), you must use the
Base Image File and the appropriate Incremental Image Files necessary to restore the computer to a
specific point-in-time.
Lock Volume: A software request to gain exclusive access to a particular drive. Locking the volume
prevents other software programs from changing the file system or opening files during the process of
writing the image file.
Microsoft VolSnap: The proprietary Microsoft snapshot technology.
Microsoft Volume Shadow Copy Service (VSS): The backup infrastructure for Microsoft Windows
XP and Microsoft Windows Server 2003 operating systems, as well as a mechanism for creating
consistent point-in-time copies of data. The Volume Shadow Copy Service produces consistent
snapshots by coordinating with business applications, file-system services, backup applications, fastrecovery solutions, and storage hardware.
Mount as Drive Letter: The process of assigning volumes (active primary partitions and logical
partitions) to specific letter designators in the root namespace of a Microsoft operating system. Unlike
mount points (see Mount Point), drive letter assignment permits only letters in the namespace, and
they solely represent volumes. In other words, it is a process of naming the roots of the "forest" that
represents the file-system (with each volume being an independent tree therein).
Mount Point: A directory on a volume that an application can use to "mount" (set up for use) a
different volume. Mount points overcome the limitation of drive letters (see Mount as Drive Letter) and
allow for more logical organization of files and folders.
Mounted Volume: The ability to see and use a backup image that is physically located somewhere
else on the network. When mounted, the backup image appears as a volume and behaves as if it is a
part of the local computer system. Mounted volumes are read/write capable so users can update
existing image files, scan for viruses or other malware, and repair the image file.
Operating System: Software that, after being loaded into the computer by a boot program, manages
all other programs on a computer. Other programs are called applications or application programs.
Partition: The portion of a physical disk that functions as though it were a physically separate disk.
Once created, a partition must be formatted and assigned a drive letter before data can be stored on it.
On basic disks, partitions can contain basic volumes, which include primary partitions and logical
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drives. On dynamic disks, partitions are known as dynamic volumes and come in the following types:
simple, striped, spanned, mirrored, and RAID–5 (striped with parity) volumes.
Restoring: The activity of retrieving computer data from a previously saved backup image file.
Snapshot: A type of backup that provides a point-in-time view of a volume. When you perform a
backup or scheduled backup, ShadowProtect uses either StorageCraft Volume Snapshot Manager
(VSM) or Microsoft Volume Shadow Copy Service (VSS) to take a snapshot of the volume. Any
changes that occur to the volume after the snapshot is taken are not included in the backup.
.spf: A file extension representing a ShadowProtect full or base image file.
.spi: A file extension representing a ShadowProtect incremental or differential image file.
.sp(number): A file extension representing a ShadowProtect image file that spans multiple files. The
number following .sp is the sequence of the file in the spanned image file group.
Point-In-Time Backup: A backup routine that lets you restore a file, folder, or the entire system to a
specific point-in-time. Point-in-time backups are often used to roll-back a computer to a point prior to a
computer problem.
Protected Volumes: Volumes that users have selected for backup by ShadowProtect.
RAID: Redundant Array of Independent Disks. A collection of disk drives that offers increased
performance and fault tolerance. There are a number of different RAID levels. The three most
commonly used are 0, 1, and 5:
Level 0: striping without parity (spreading out blocks of each file across multiple disks).
Level 1: disk mirroring or duplexing.
Level 5: block-level striping with distributed parity.
Real-Time: A level of computer responsiveness that a user perceives as essentially immediate, or
that enables the computer to keep up with some external process such as backing up.
Recovery Environment: See StorageCraft Recovery Environment.
Remote Computer (Node): A computer that is physically located somewhere else on a network but
is accessible from a local computer.
Service: A program, routine, or process that performs a specific system function to support other
programs, particularly at a low (close to the hardware) level.
Scheduled Job: A job created in the ShadowProtect interface. Scheduled jobs let ShadowProtect
backup events to occur automatically.
Spanned Image Set: A Backup Image File that has been divided into multiple smaller files for easier
management or storage. This lets you save the Backup Image File to removable media such as a CD
or DVD.
StorageCraft Recovery Environment: A secondary boot environment (or operating system) that
gives a user the functionality necessary to access and restore Backup Image Files on a network. This
environment is typically used when a drive cannot be restored from within Windows or when the
computer has suffered a catastrophic failure and the entire hard drive must be restored.
System downtime: The amount of time a server or PC is offline and inaccessible to users. This is
commonly known as having the system out of production.
System Volume: The volume that stores the boot files necessary to load an operating system.
Typically, this is the C:\ volume.
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Tray Icon: A graphical representation of a computer program or application. For example,
ShadowProtect uses a tray icon for the user to gain information about the program. Tray icons reside
in the system tray.
UNC (Universal Naming Convention): A method used to identify folders, files and programs on a
network computer. A UNC path begins with two backslashes \\ followed by the server name, share
name, directory and filename. For example, \\server_name\share_name\backup_name.spi.
Unprotected Volumes: Volumes not protected by ShadowProtect.
User Interface (UI): The portions of a computer system with which a user interacts (display,
keyboard, mouse, etc.) and the portion of a software program that accepts and responds to user
interaction.
Virtual Private Network (VPN): A private data network that makes use of the public
telecommunication infrastructure. VPNs maintain privacy through the use of tunneling protocols,
encryption, and other security procedures.
VirtualBoot: The ability to create a Virtual Machine based on an existing backup image chain. Once
started, the VM provides complete access to data, applications, and services provided by the original
system, in a state corresponding with the last Incremental image included in the VM.
Virtual Volume: A locally referenced volume that does not physically exist on the system.
ShadowProtect uses virtual volumes for the benefit of protecting computer systems.
Volume: An area of storage on a hard disk. A volume is formatted by using a file system, such as file
allocation table (FAT) or NTFS, and typically has a drive letter assigned to it. A single hard disk can
have multiple volumes, and volumes can also span multiple disks.
VSS Aware: An application designed to work with Microsoft Volume Shadow Copy Services (VSS)
framework to ensure consistent data backup.
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Chapter 17: End User License Agreement
END-USER LICENSE AGREEMENT FOR SELECT SHADOWPROTECT TM SOFTWARE PRODUCTS
Pl ea s e ca reful l y rea d the terms a nd condi ti ons of thi s l i cens e a greement (the “Agreement”) for the fol l owi ng
vers i ons of Stora geCra ft Technol ogy Corpora ti on™ s oftwa re: Sha dowProtect Server 4.0, Sha dowProtect Sma l l
Bus i nes s Server 4.0, a nd Sha dowProtect Des ktop 4.0, whi ch a re s i ngl y referred to a s a "ShadowProtect Product"
a nd col l ecti vel y a s "ShadowProtect Products". Thi s Agreement s peci fi es the terms a nd condi ti ons of your us e of
a ny of the foregoi ng Sha dowProtect Products . Stora geCra ft Technol ogy Corpora ti on (“StorageCraft”), i s wi l l i ng to
l i cens e a Sha dowProtect Product to you a s the i ndi vi dua l , compa ny, or l ega l enti ty tha t wi l l be us i ng the
Sha dowProtect Product (“you” or “Licensee”), but onl y on the condi ti on tha t you a ccept a l l of the terms of thi s
Agreement. Thi s Agreement i s a l ega l a nd enforcea bl e contra ct between Stora geCra ft a nd you. By openi ng a
pa cka ge conta i ni ng a Sha dowProtect Product, brea ki ng the s ea l on a Sha dowProtect Product, cl i cki ng the “I
Agree” button, or otherwi s e i ndi ca ti ng a s s ent by i ns ta l l i ng, l oa di ng, us i ng, reta i ni ng, or copyi ng a
Sha dowProtect Product, you a ccept thi s Agreement a nd a gree to a l l the terms a nd condi ti ons i t conta i ns . If you
do not a gree to thes e terms a nd condi ti ons , do not open the pa cka gi ng, brea k the s ea l , us e the Sha dowProtect
Product, or cl i ck the “I Agree” button. You ma y conta ct Stora geCra ft’s cus tomer s ervi ce depa rtment for
i nforma ti on on obta i ni ng a refund of the Li cens e Fee pa i d a nd i ns tructi ons on returni ng the Sha dowProtect
Product a nd Documenta ti on. If you i ns ta l l or otherwi s e us e the Sha dowProtect Product under a ny tri a l ,
eva l ua ti on or purcha s e tra ns a cti on, your conduct cons ti tutes a ccepta nce of thi s Agreement a nd you wi l l be
bound by a l l of i ts terms a nd condi ti ons . Stora geCra ft a nd Li cens ee a re s ometi mes col l ecti vel y referred to i n
thi s Agreement a s “the Parties” a nd i ndi vi dua l l y a s a “Party.” You ma y a cces s Stora geCra ft’s webs i te a t www.
s tora gecra ft.com/l ega l / to downl oa d a nd pri nt a copy of thi s Agreement.
Section 1Definitions.
1.1.“Archival Use” mea ns the crea ti on a nd confi denti a l s tora ge by Li cens ee of a s i ngl e copy of the Softwa re
for us e by Li cens ee onl y i n the event tha t the Ori gi na l Copy fa i l s to functi on properl y. Archi va l Us e does
not i ncl ude s i mul ta neous us e of the Ori gi na l Copy a nd the a rchi va l copy, whi ch s i mul ta neous us e i s
prohi bi ted by thi s Agreement.
1.2.“Desktop Operating System” mea ns a ny broa dl y rel ea s ed Mi cros oft opera ti ng s ys tem i ntended for des ktop
computers i ncl udi ng but not l i mi ted to: Wi ndows 2000 Profes s i ona l , Wi ndows XP Home Edi ti on, Wi ndows
XP Profes s i ona l , Wi ndows Vi s ta , a nd Wi ndows 7.
1.3.“Documentation” mea ns a l l on-l i ne hel p fi l es or wri tten i ns tructi on ma nua l s a nd us er gui des a ddres s i ng
the us e of the Softwa re.
1.4.“Effective Date” mea ns the da te on whi ch Li cens ee ha s both pa i d the Li cens e Fee a nd a ccepted thi s
Agreement.
1.5. “Intellectual Property Rights” mea ns a l l of Stora geCra ft’s owners hi p ri ghts a s s oci a ted wi th i ntel l ectua l
property a nd the Softwa re, i ncl udi ng but not l i mi ted to pa tents , copyri ghts , tra dema rks , a nd tra de s ecrets ,
a nd a ny a nd a l l ri ghts to excl ude exi s ti ng from ti me to ti me i n a s peci fi ed juri s di cti on under pa tent l a w,
copyri ght l a w, mora l ri ghts l a w, tra de-s ecret l a w, tra dema rk l a w, unfa i r competi ti on l a w, or other s i mi l a r
ri ghts .
1.6.“License Fee” mea ns the pri ce pa i d by Li cens ee to Stora geCra ft or i ts res el l er, di s tri butor, or a uthori zed
repres enta ti ve i n excha nge for a l i cens e to us e the Softwa re i n a ccorda nce wi th the l i mi ta ti ons
es ta bl i s hed i n thi s Agreement.
1.7. “Object Code” mea ns the output of a compi l er a fter i t proces s es Stora geCra ft’s s ource code i n the form of
a n executa bl e, dl l , or l i bra ry fi l e.
1.8.“Original Copy” mea ns the s i ngl e copy of the Softwa re provi ded to Li cens ee i n conjuncti on wi th thi s
Agreement.
1.9.“Physical System” mea ns a computer ha rdwa re devi ce s upported by a n i ns ta l l ed opera ti ng s ys tem.
1.10.“Server Operating System” mea ns a ny broa dl y rel ea s ed Mi cros oft opera ti ng s ys tem i ntended for s erver
computers i ncl udi ng but not l i mi ted to: Wi ndows Server 2003 a nd Wi ndows Server 2008.
1.11."ShadowProtect Desktop" mea ns Sha dowProtect Des ktop Vers i on 4.0 a nd i ncl udes two components : the
executa bl e progra m whi ch i s i ns ta l l ed on the computer a nd the Recovery Envi ronment. Sha dowProtect
Des ktop does not i ncl ude s epa ra tel y l i cens ed, fee-bea ri ng products or a dd-on modul es . Sha dowProtect
Des ktop i s l i cens ed for us e on ei ther a Phys i ca l Sys tem or a Vi rtua l Ma chi ne, but not both.
1.12.ShadowProtect SBS" mea ns Sha dowProtect Sma l l Bus i nes s Server Vers i on 4.0 a nd i ncl udes two
components : the executa bl e progra m whi ch i s i ns ta l l ed on the computer a nd the Recovery Envi ronment.
Sha dowProtect SBS does not i ncl ude s epa ra tel y l i cens ed, fee-bea ri ng products or a dd-on modul es .
Sha dowProtect SBS i s l i cens ed for us e on ei ther a Phys i ca l Sys tem or a Vi rtua l Ma chi ne, but not both.
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1.13.ShadowProtect Server" mea ns Sha dowProtect Server Vers i on 4.0 a nd i ncl udes two components : the
executa bl e progra m whi ch i s i ns ta l l ed on the computer a nd the Recovery Envi ronment. Sha dowProtect
Server does not i ncl ude s epa ra tel y l i cens ed, fee-bea ri ng products or a dd-on modul es . Sha dowProtect
Server i s l i cens ed for us e on ei ther a Phys i ca l Sys tem or a Vi rtua l Ma chi ne, but not both.
1.14.“Small Business Server Operating System” mea ns Mi cros oft Sma l l Bus i nes s Server 2000, Mi cros oft Sma l l
Bus i nes s Server 2003, a nd Mi cros oft Sma l l Bus i nes s Server 2008.
1.15."Software" mea ns : (a ) the s peci fi c Sha dowProtect Product to whi ch you a re l i cens ed i n a ccorda nce wi th
thi s Agreement a nd i n excha nge for whi ch you pa i d a Li cens e Fee to Stora geCra ft or i ts a uthori zed
res el l er, a nd/or (b) the s peci fi c Sha dowProtect Product to whi ch you ha ve been gra nted a n Eva l ua ti on
Li cens e, a Tri a l Li cens e, or a n NFR Li cens e. The Softwa re i ncl udes three propri eta ry Stora geCra ft
a ppl i ca ti ons : (a ) Vi rtua l Boot™, (b) Sha dowProtect Ima geMa na ger™ Servi ce a nd Ima geMa na ger Cl i ent
(col l ecti vel y "ImageManger"), a nd (c) Sha dowProtect KeyFi l eMa ker™ a nd other KeyFi l e Tool s (col l ecti vel y "
KeyFileMaker"). “StorageCraft Recovery Environment” mea ns the boota bl e CD component of the Softwa re
tha t i ncl udes Wi nPE under l i cens e gra nted by Mi cros oft Li cens i ng, GP to Stora geCra ft a nd whi ch provi des a
boota bl e opera ti ng s ys tem envi ronment tha t runs a vers i on of the Softwa re.
1.16.“Use” mea ns the a bi l i ty to run, execute, a nd di s pl a y the Softwa re i n i ts Object Code form, but onl y i n
a ccorda nce wi th the terms of thi s Agreement.
1.17.“Virtual Machine” mea ns a s oftwa re emul a ti on of a computer ha rdwa re devi ce wi th opera ti ng s ys tem.
VMwa re® a nd Vi rtua l PC a re exa mpl es of s oftwa re tha t crea te vi rtua l ma chi nes . “Desktop Virtual Machine”
mea ns a Vi rtua l Ma chi ne empl oyi ng a Des ktop Opera ti ng Sys tem (e.g., VMwa re runni ng the Wi ndows 7
opera ti ng s ys tem). “Server Virtual Machine” mea ns a Vi rtua l Ma chi ne empl oyi ng a Server Opera ti ng Sys tem
(e.g., VMwa re runni ng the Wi ndows Server 2008 opera ti ng s ys tem). “Small Business Server Virtual Machine”
mea ns a Vi rtua l Ma chi ne empl oyi ng a Sma l l Bus i nes s Server opera ti ng s ys tem (e.g., VMwa re runni ng the
Wi ndows Sma l l Bus i nes s Server 2008 opera ti ng s ys tem).
1.18.“Volume License Certificate” mea ns a l i cens e certi fi ca te i s s ued by Stora geCra ft a uthori zi ng the Li cens ee
to i ns ta l l a nd us e mul ti pl e copi es of the Softwa re i n s uch numbers a s a re a uthori zed by the certi fi ca te.
Section 2Proprietary Rights. Thi s i s a l i cens e a nd not a s a l e. The Softwa re a nd Documenta ti on a re propri eta ry
products of Stora geCra ft or of i ts l i cens ors a nd a re protected under Uni ted Sta tes copyri ght l a ws a nd
i nterna ti ona l trea ty provi s i ons . Nothi ng i n thi s Li cens e cons ti tutes a wa i ver of Stora geCra ft’s ri ghts under U.
S. or i nterna ti ona l copyri ght l a w or a ny other l a w. Owners hi p of the Softwa re a nd a l l copi es , modi fi ca ti ons ,
tra ns l a ti ons , components , fea tures , a nd merged porti ons of the Softwa re s ha l l a t a l l ti mes rema i n wi th
Stora geCra ft, i ncl udi ng a l l copyri ghts , pa tent ri ghts , tra de s ecret ri ghts , tra dema rks a nd other i ntel l ectua l
property ri ghts i n the Softwa re a nd Documenta ti on. Li cens ee’s ri ghts to us e the Softwa re a re s peci fi ed a nd
l i mi ted s ol el y to thos e ri ghts i denti fi ed i n thi s Agreement. Stora geCra ft reta i ns a l l ri ghts not expres s l y
gra nted to Li cens ee i n thi s Agreement. Thi s Agreement governs a ny upgra des , rel ea s es , revi s i ons , or
enha ncements to the Softwa re tha t Stora geCra ft ma y furni s h to the Li cens ee. Thi s Agreement does not
i ncl ude a gra nt to Li cens ee of a ny: (a ) owners hi p ri ght, ti tl e, i nteres t, s ecuri ty i nteres t, or other i nteres t i n
the s ource code or Object Code of the Softwa re or i n Stora geCra ft’s Intel l ectua l Property Ri ghts ; (b)
Intel l ectua l Property Ri ghts rel a ti ng to the Softwa re, a ny copy of a ny pa rt of the Softwa re or the
Documenta ti on; (c) ri ght or a uthori ty to modi fy the Softwa re; (d) ri ght to us e the Softwa re to devel op
deri va ti ves or deri va ti ve works of the Softwa re; (e) ri ght to revers e engi neer, decompi l e, recompi l e the
Softwa re or otherwi s e a ttempt to di s cover s ource code or tra de s ecrets rel a ted to the Softwa re; (f) ri ght to
copy the Softwa re except a s expres s l y permi tted i n thi s Agreement; (g) ri ght to copy, s ubl i cens e, s el l , l end,
rent, l ea s e, gi ve, tra ns fer, a s s i gn, or otherwi s e di s pos e of a l l or a ny porti on of the Softwa re or a ny i nteres t
i n the Softwa re wi thout Stora geCra ft’s pri or wri tten cons ent (a ny s uch di s pos i ti on ma de wi thout s uch
cons ent s ha l l be nul l a nd voi d); a nd/or (h) ri ght to remove, obs cure or a l ter a ny noti ce of pa tent, copyri ght,
tra de s ecret, tra dema rk, or other propri eta ry ri ght of Stora geCra ft.
Section 3Grant of License. Li cens ee i s gra nted a ful l y pa i d, worl dwi de, perpetua l , revoca bl e, non-excl us i ve, nontra ns fera bl e, non-s ubl i cens ea bl e, l i cens e-fee bea ri ng, Object Code l i cens e, s ubject to ti mel y pa yment to
Stora geCra ft of the Li cens e Fee, to do the fol l owi ng: (a ) us e the Softwa re a nd Documenta ti on i n i ts "a s i s "
a nd unmodi fi ed form a s provi ded to you by Stora geCra ft; (b) us e the Softwa re s tri ctl y i n a ccorda nce wi th the
terms of thi s Agreement a nd wi th the s peci fi c condi ti ons a nd l i mi ta ti ons a ppl i ca bl e to the s peci fi c type of
Softwa re l i cens ed by Li cens ee, a s s peci fi ed i n Secti on 3.1 bel ow; (c) copy the Softwa re for Archi va l Us e onl y,
provi ded tha t a l l ti tl es , tra dema rk s ymbol s , copyri ght s ymbol s a nd l egends , a nd other propri eta ry ma rki ngs
a re reproduced on s uch a rchi va l copy, a nd provi ded further tha t the a rchi va l copy i s not us ed unl es s the
ori gi na l copy of the Softwa re becomes i nopera bl e or fa i l s to functi on properl y; a nd (d) us e the Softwa re on
onl y one computer, unl es s Li cens ee ha s a cqui red a Vol ume Li cens e Certi fi ca te, i n whi ch ca s e the Li cens ee
i s a uthori zed to i ns ta l l a nd opera te the Softwa re on a s ma ny computers a s a re a uthori zed by the Vol ume
Li cens e Certi fi ca te. LICENSEE UNDERSTANDS AND AGREES THAT WITH RESPECT TO CERTAIN LICENSES COVERED
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BY THIS AGREEMENT ALL FUNCTIONALITY OF THE SOFTWARE WILL TIME OUT AND CEASE TO OPERATE AS
GOVERNED BY THE AGREEMENT AND SOFTWARE. IN THE EVENT THAT THE SOFTWARE TIMES OUT AND CEASES TO
OPERATE, STORAGECRAFT SHALL HAVE NO RESPONSIBILITY TO PROVIDE SERVICE OR SUPPORT FOR THE
SOFTWARE.
3.1.Additional Terms, Conditions, and Limitations Applicable to Specific Versions of the Software.
3.1.1.Desktop License – A Des ktop Li cens e to the Softwa re permi ts us e onl y on a Des ktop Opera ti ng Sys tem.
Thi s vers i on of the Softwa re ma y be a cqui red by the Li cens ee ei ther by purcha s e of a pa cka ged boxed
vers i on or by downl oa d from the webs tore of Stora geCra ft or one of i ts res el l er pa rtners .
3.1.2.Small Business Server – A Sma l l Bus i nes s Server Li cens e to the Softwa re permi ts us e onl y on a Sma l l
Bus i nes s Server Opera ti ng Sys tem. Thi s vers i on of the Softwa re ma y be a cqui red by the Li cens ee ei ther
by purcha s e of a pa cka ged boxed vers i on or by downl oa d from the webs tore of Stora geCra ft or one of
i ts res el l er pa rtners .
3.1.3.Server License – A Server Li cens e to the Softwa re permi ts us e onl y on a Server Opera ti ng Sys tem. Thi s
vers i on of the Softwa re ma y be a cqui red by the Li cens ee ei ther by purcha s e of a pa cka ged boxed
vers i on or by downl oa d from Stora geCra ft’s webs tore or one of Stora geCra ft’s res el l er pa rtners .
3.1.4.Evaluation License – An Eva l ua ti on Li cens e i s a l i cens e to the Softwa re tha t permi ts Li cens ee to us e a l l
fea tures of the corres pondi ng Sha dowProtect Product a nd i ncl udes the Stora geCra ft Recovery
Envi ronment. Thi s l i cens e i s provi ded to the Li cens ee for eva l ua ti on purpos es for the s peci fi c
eva l ua ti on peri od a l l owed by the Softwa re. The Softwa re wi l l provi de Li cens ee wi th a dva nce noti ce of
the expi ra ti on of the Softwa re before tha t event occurs . Thi s Li cens e ma y not be copi ed, di s tri buted or
res ol d. Thi s vers i on of the Softwa re ma y be a cqui red by the Li cens ee ba s ed on a pre-qua l i fi ed
tra ns a cti on of a pa cka ged boxed vers i on or by downl oa d from the webs i te of Stora geCra ft or one of i ts
res el l er pa rtners .
3.1.5.Trial License – A Tri a l Li cens e i s a l i cens e to the corres pondi ng Sha dowProtect Product tha t permi ts
the Li cens ee to us e a l l fea tures of the ful l l i cens e, but does not i ncl ude the Stora geCra ft Recovery
Envi ronment. Thi s vers i on of the Softwa re ma y be a cqui red by the Li cens ee by downl oa d from
Stora geCra ft’s webs i te or a downl oa d provi der a uthori zed by Stora geCra ft.
3.1.6.Not for Resale (“NFR”) Software License – An NFR Softwa re Li cens e permi ts the Li cens ee to us e the
Softwa re for promoti ona l purpos es a t no or reduced cos t to Li cens ee. Thi s l i cens e ma y not be copi ed,
di s tri buted or res ol d. The el ectroni c del i very, pa cka gi ng or medi a on whi ch the NFR Softwa re i s
provi ded i s ma rked “NFR” or “Not For Res a l e.” Thi s vers i on of the Softwa re ma y be a cqui red by the
Li cens ee ei ther a s a pa cka ged boxed vers i on provi ded by Stora geCra ft or by downl oa d from the
webs tore of Stora geCra ft or one of i ts res el l er pa rtners .
3.1.7.Desktop Virtual Machine License – A Des ktop Vi rtua l Ma chi ne Li cens e to the Softwa re permi ts us e onl y
on a Vi rtua l Ma chi ne runni ng a Des ktop Opera ti ng Sys tem. Thi s l i cens e does not a uthori ze the
Li cens ee to i ns ta l l a nd us e the Softwa re on a Phys i ca l Sys tem. Wi th the excepti on tha t the us e of the
Softwa re gra nted under thi s Li cens e i s l i mi ted to a Des ktop Vi rtua l Ma chi ne, a l l other ri ghts gra nted
a nd l i mi ta ti ons i mpos ed under the Des ktop Li cens e a ppl y. Thi s vers i on of the Softwa re ma y be
a cqui red by the Li cens ee ei ther by purcha s e of a pa cka ged boxed vers i on or by downl oa d from the
webs tore of Stora geCra ft or one of i ts res el l er pa rtners .
3.1.8.Small Business Server Virtual Machine License – A Sma l l Bus i nes s Server Vi rtua l Ma chi ne Li cens e to the
Softwa re permi ts us e onl y on a Vi rtua l Ma chi ne runni ng a Sma l l Bus i nes s Server Opera ti ng Sys tem.
Thi s l i cens e does not a uthori ze the Li cens ee to i ns ta l l a nd us e the Softwa re on a Phys i ca l Sys tem.
Wi th the excepti on tha t the us e of the Softwa re gra nted under thi s Li cens e i s l i mi ted to a Sma l l
Bus i nes s Server Vi rtua l Ma chi ne, a l l other ri ghts gra nted a nd l i mi ta ti ons i mpos ed under the Sma l l
Bus i nes s Server Li cens e a ppl y. Thi s vers i on of the Softwa re ma y be a cqui red by the Li cens ee ei ther by
purcha s e of a pa cka ged boxed vers i on or by downl oa d from the webs tore of Stora geCra ft or one of i ts
res el l er pa rtners .
3.1.9.Server Virtual Machine License – A Server Vi rtua l Ma chi ne Li cens e to the Softwa re permi ts us e onl y on a
Vi rtua l Ma chi ne runni ng a Server Opera ti ng Sys tem. Thi s l i cens e does not a uthori ze the Li cens ee to
i ns ta l l a nd us e the Softwa re on a Phys i ca l Sys tem. Wi th the excepti on tha t the us e of the Softwa re
gra nted under thi s Li cens e i s l i mi ted to a Server Vi rtua l Ma chi ne, a l l other ri ghts gra nted a nd
l i mi ta ti ons i mpos ed under the Server Li cens e a ppl y. Thi s vers i on of the Softwa re ma y be a cqui red by
the Li cens ee ei ther by purcha s e of a pa cka ged boxed vers i on or by downl oa d from the webs tore of
Stora geCra ft or one of i ts res el l er pa rtners .
Section 4LICENSE RESTRICTIONS. Li cens ee a grees tha t i t wi l l not, di rectl y or through a ny pa rent, s ubs i di a ry,
a ffi l i a te, a gent or thi rd pa rty do a ny of the fol l owi ng wi th res pect to the l i cens ed Softwa re a nd
Documenta ti on:
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4.1.Us e the Softwa re or Documenta ti on i n vi ol a ti on of the terms of thi s Agreement;
4.2.Copy the Softwa re or Documenta ti on except a s s peci fi ca l l y a uthorized by thi s Agreement;
4.3.Permi t concurrent us e of a ny copy of the Softwa re except a s a uthori zed by a Vol ume Li cens e Certi fi ca te;
4.4.Sel l , l ea s e, l i cens e, s ubl i cens e or otherwi s e dea l wi th a ny porti on of the Softwa re or Documenta ti on;
4.5.Provi de, l end, di s cl os e, di vul ge or ma ke a va i l a bl e to, or permi t us e of the Softwa re or Documenta ti on by
pers ons other tha n the Li cens ee wi thout Stora geCra ft’s pri or wri tten cons ent;
4.6.Rent, l ea s e, gra nt a s ecuri ty i nteres t i n, or otherwi s e tra ns fer ri ghts to, or pos s es s i on of, the Softwa re or
a ny copy thereof;
4.7.Us e the Softwa re i n a ny s ervi ce burea u or ti me s ha ri ng a rra ngement;
4.8.Remove or a l ter a ny propri eta ry noti ces , l a bel s or l egends on a ny copy of the Softwa re or Documenta ti on;
4.9.Shi p or tra ns mi t (di rectl y or i ndi rectl y) a ny copi es of the Softwa re or Documenta ti on to a ny country or
des ti na ti on prohi bi ted by the Uni ted Sta tes Government;
4.10.Revers e engi neer, decompi l e, di s a s s embl e, modi fy, tra ns l a te, ma ke a ny a ttempt to di s cover the s ource
code of the Softwa re, or crea te deri va ti ve works from, empl oy or ma ni pul a te the Softwa re;
4.11.Us e a Vi rtua l Ma chi ne l i cens e on a Phys i ca l Sys tem;
4.12.Us e KeyFi l eMa ker or Vi rtua l Boot i n conjuncti on wi th i ma ge fi l es crea ted by s oftwa re other tha n the
s peci fi c s ea t of l i cens ed Softwa re wi th whi ch KeyFi l eMa ker or Vi rtua l Boot were provi ded to Li cens ee; a nd
4.13.As s i gn or tra ns fer the ri ghts gra nted to Li cens ee under thi s Agreement on a perma nent ba s i s unl es s : (a )
Li cens ee reta i ns no copi es of the Softwa re, (b) pri or to s uch a s s i gnment or tra ns fer, the a s s i gnee or
tra ns feree a grees i n wri ti ng to the terms a nd condi ti ons of thi s Agreement, a nd (c) Stora geCra ft cons ents
to s uch a s s i gnment or tra ns fer.
Section 5License Fee.
5.1.License Fee. Wi th the excepti on of a n Eva l ua ti on Li cens e, Tri a l Li cens e, a nd NFR Li cens e, Li cens ee i s
requi red to pa y the Li cens e Fee es ta bl i s hed by Stora geCra ft or i ts a uthori zed res el l er.
5.2.Upgrade License Fee. If a n upgra de i s offered by Stora geCra ft, Li cens ee s ha l l be enti tl ed to a cqui re s uch
upgra de under the ri ghts gra nted a nd l i mi ta ti ons i mpos ed by Stora geCra ft under i ts upgra de progra m.
Stora geCra ft does not ma ke a ny wa rra nty, promi s e, or commi tment to upgra de the Softwa re.
5.3.Maintenance and Support Fee. Thi s Li cens e does not provi de Li cens ee wi th a ny ri ghts to ma i ntena nce or
s upport of the Softwa re except for the Softwa re s upport s peci fi ed i n thi s Agreement. Ma i ntena nce or
upgra ded s upport beyond the s upport gra nted i n thi s Agreement i s a va i l a bl e by a s epa ra te ma i ntena nce
or upgra ded s upport a greement wi th Stora geCra ft.
Section 6Support. Li cens ee i s enti tl ed to pa rti ci pa te i n Stora geCra ft’s s upport progra m i n cons i dera ti on for i ts
pa yment of the Li cens e Fee. Stora geCra ft’s s upport progra m i ncl udes the fol l owi ng opti ons , a l l of whi ch ca n
be a cces s ed a nd us ed by Li cens ee: Stora geCra ft’s on-l i ne s upport s ys tem; Stora geCra ft modera ted us er
forum; a nd Stora geCra ft’s Knowl edge Ba s e, whi ch i s a ques ti on a nd a ns wer res ource i ncl udi ng frequentl y
a s ked ques ti ons .
Section 7Termination. Thi s Agreement i s effecti ve unti l termi na ted a s permi tted i n thi s Secti on. Ei ther Pa rty
ma y termi na te thi s Li cens e for conveni ence a t a ny ti me, but i n the event of Stora geCra ft’s termi na ti on for
conveni ence, i t s ha l l refund to Li cens ee the Li cens e Fee pa i d by Li cens ee. Stora geCra ft ma y termi na te thi s
Li cens e effecti ve i mmedi a tel y by provi di ng a noti ce to Li cens ee of brea ch of a ny provi s i on i n Secti ons 3, 4
a nd 5. Stora geCra ft ma y termi na te thi s Agreement on twenty (20) da ys wri tten noti ce to Li cens ee i f Li cens ee
brea ches a ny other provi s i on of thi s Agreement a nd fa i l s to cure s uch brea ch wi thi n twenty (20) da ys a fter
recei vi ng wri tten noti ce of the brea ch from Stora geCra ft. Upon termi na ti on of thi s Li cens e, Li cens ee mus t
cea s e a l l us e of the Softwa re a nd Documenta ti on a nd des troy a l l copi es of the Softwa re a nd
Documenta ti on.
Section 8Limited Warranty, Exclusive Remedy. Stora geCra ft wa rra nts tha t, for s i xty (60) da ys a fter the da te
Li cens ee fi rs t purcha s ed the Softwa re from Stora geCra ft or i ts res el l er, di s tri butor or a uthori zed
repres enta ti ve, tha t the medi a on whi ch the Softwa re i s provi ded wi l l be free from defects i n ma teri a l s a nd
workma ns hi p under norma l us e. Thi s wa rra nty gi ves Li cens ee s peci fi c ri ghts a nd Li cens ee ma y a l s o ha ve
other ri ghts tha t va ry from s ta te to s ta te. In the event of a ny brea ch of thi s l i mi ted wa rra nty, Li cens ee’s s ol e
a nd excl us i ve remedy a ga i ns t Stora geCra ft a nd i ts a gents , empl oyees , repres enta ti ves , offi cers , di rectors ,
contra ctors , dea l ers , a nd di s tri butors i s , a t Stora geCra ft’s opti on, ei ther (i ) return of the l i cens e fee pa i d for
the l i cens e or (i i ) repl a cement of the defecti ve medi a on whi ch the Softwa re i s conta i ned, provi ded tha t
Li cens ee noti fi es Stora geCra ft of the nonconforma nce wi thi n the s i xty (60) da y wa rra nty peri od. Li cens ee
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mus t return the defecti ve medi a to Stora geCra ft or i ts dea l er, di s tri butor or a uthori zed repres enta ti ve a t
Li cens ee’s expens e, together wi th a copy of Li cens ee’s proof of pa yment of the l i cens e fee wi thi n the s i xty
(60) da y wa rra nty peri od. Thi s l i mi ted wa rra nty i s voi d i f the defect i s the res ul t of a l tera ti on, a bus e,
da ma ge or mi s a ppl i ca ti on. Any repl a cement medi a wi l l be wa rra nted for the rema i nder of the ori gi na l
wa rra nty peri od, or thi rty (30) da ys , whi chever i s l onger.
Section 9Disclaimer of Warranties. STORAGECRAFT DOES NOT WARRANT THAT THE SOFTWARE WILL MEET LICENSEE’S
REQUIREMENTS OR THAT IT'S OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE. EXCEPT AS EXPRESSLY
STATED IN THIS AGREEMENT, THE SOFTWARE IS PROVIDED AND LICENSED "AS IS" AND WITH ALL FAULTS. THERE
ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS, EXPRESS OR IMPLIED, WRITTEN OR ORAL, ARISING BY
STATUTE, OPERATION OF LAW, OR OTHERWISE, REGARDING THE SOFTWARE OR ANY OTHER PRODUCT OR SERVICE
PROVIDED HEREUNDER OR IN CONNECTION HEREWITH. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, STORAGECRAFT AND ITS DEALERS, DISTRIBUTORS AND AUTHORIZED REPRESENTATIVES DISCLAIM ALL
WARRANTIES AND CONDITIONS, WHETHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING WITHOUT LIMITATION
ANY (IF ANY) WARRANTIES OR CONDITIONS OF OR RELATED TO: MERCHANTABILITY, DURABILITY, FITNESS FOR A
PARTICULAR PURPOSE, LACK OF VIRUSES, NONINFRINGEMENT, ACCURACY OR COMPLETENESS OF RESPONSES,
RESULTS, WORKMANLIKE EFFORT, AND LACK OF NEGLIGENCE. ALSO, TO THE MAXIMUM EXTENT PERMITTED BY
LAW, THERE IS NO WARRANTY, DUTY, OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION,
CORRESPONDENCE TO DESCRIPTION, OR NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF USE OR
PERFORMANCE OF THE SOFTWARE REMAINS WITH LICENSEE. IF ANY IMPLIED WARRANTY IS NOT DISCLAIMED
UNDER APPLICABLE LAW, THEN SUCH IMPLIED WARRANTY IS LIMITED TO THIRTY (30) DAYS FROM THE DATE
LICENSEE ACQUIRED THE SOFTWARE FROM STORAGECRAFT OR ITS DEALERS, DISTRIBUTORS OR AUTHORIZED
REPRESENTATIVES AND IS SUBJECT TO THE EXCLUSIVE REMEDY PROVISION SET FORTH IN SECTION 8. SOME
JURISDICTIONS DO NOT PERMIT LIMITATIONS ON IMPLIED WARRANTIES, SO THE FOREGOING THIRTY (30) DAY
TIME LIMITATION ON IMPLIED WARRANTIES MAY NOT APPLY TO LICENSEE. THE LIMITED WARRANTY HEREIN
GIVES LICENSEE SPECIFIC LEGAL RIGHTS AND LICENSEE MAY ALSO HAVE OTHER LEGAL RIGHTS WHICH VARY BY
JURISDICTION. WARRANTY INQUIRIES MAY BE SENT TO STORAGECRAFT AT: LEGAL@STORAGECRAFT.COM OR TO
LEGAL DEPARTMENT, 121 WEST ELECTION ROAD, SUITE 110, DRAPER, UTAH 84020, U.S.A. NO AGREEMENTS
VARYING OR EXTENDING THE FOREGOING WARRANTIES OR LIMITATIONS WILL BE BINDING ON EITHER PARTY
UNLESS IN WRITING AND SIGNED BY AN AUTHORIZED REPRESENTATIVE OF BOTH PARTIES.
Section 10Limitation of Liability. THE LIABILITY OF STORAGECRAFT AND THAT OF ITS DEALERS, DISTRIBUTORS AND
AUTHORIZED REPRESENTATIVES TO LICENSEE FOR ANY LOSSES SHALL BE LIMITED TO DIRECT DAMAGES AND SHALL
NOT EXCEED THE AMOUNT LICENSEE ORIGINALLY PAID FOR THE SOFTWARE. IN NO EVENT SHALL STORAGECRAFT
OR ITS DEALERS, DISTRIBUTORS OR AUTHORIZED REPRESENTATIVES BE LIABLE FOR ANY INCIDENTAL, INDIRECT,
INCIDENTAL, SPECIAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF PROFITS, USE, OR DATA; OR BUSINESS
INTERRUPTION), EVEN IF STORAGECRAFT OR ITS AGENTS OR REPRESENTATIVES HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. Thes e l i mi ta ti ons a ppl y even i n the event of fa ul t, tort, negl i gence,
mi s repres enta ti on, or s tri ct or product l i a bi l i ty. In no event s ha l l a ny pers on who ha s contri buted to a ny
pa rt of the Softwa re be l i a bl e for a ny da ma ges wha ts oever, however ca us ed, a nd on a ny theory of l i a bi l i ty,
whether i n contra ct, s tri ct l i a bi l i ty, or tort (i ncl udi ng negl i gence or otherwi s e) a ri s i ng i n a ny wa y out of the
us e of the Softwa re, even i f a dvi s ed of the pos s i bi l i ty of s uch da ma ge. Some juri s di cti ons do not a l l ow the
excl us i on or l i mi ta ti on of i nci denta l or cons equenti a l da ma ges , s o the a bove l i mi ta ti on or excl us i on ma y
not a ppl y to Li cens ee. Li cens ee rel ea s es Stora geCra ft from a l l l i a bi l i ty i n exces s of the l i a bi l i ti es tha t a re
l i mi ted by thi s Secti on, i ncl udi ng wi thout l i mi ta ti on a ny cl a i m for i ndemni fi ca ti on or contri buti on whether
a ri s i ng under s ta tutory or common l a w or otherwi s e. End us ers i n certa i n countri es (s uch a s Ma l a ys i a , New
Zea l a nd, a nd Aus tra l i a ) ma y be s ubject to certa i n cons umer protecti on l a ws uni que to thei r l oca l e a nd
whi ch l i mi t the a bi l i ty to modi fy or excl ude l i a bi l i ty. If Li cens ee a cqui red the Softwa re for the purpos es of a
bus i nes s , Li cens ee confi rms tha t a ny a ppl i ca bl e cons umer protecti on l a ws do not a ppl y. If Li cens ee
a cqui red the Softwa re i n Aus tra l i a a nd i f Stora geCra ft brea ches a condi ti on or wa rra nty i mpl i ed by
a ppl i ca bl e l a w a nd whi ch ca nnot l a wful l y be modi fi ed or excl uded by thi s Agreement then, to the extent
permi tted by l a w, Stora geCra ft’s l i a bi l i ty to Li cens ee i s l i mi ted, a t Stora geCra ft’s opti on, to: (a ) repl a cement
or repa i r of the Softwa re a nd/or re-s uppl y of cus tomer s upport; or (b) the cos t of repl a ci ng or repa i ri ng the
Softwa re a nd/or the cos t of re-s uppl yi ng cus tomer s upport.
Section 11United States Government Restricted Rights. RESTRICTED RIGHTS LEGEND. Al l Stora geCra ft products a nd
documenta ti on a re commerci a l i n na ture. The s oftwa re a nd s oftwa re documenta ti on a re "Commerci a l
Items ", a s tha t term i s defi ned i n 48 C.F.R. § 2.101, cons i s ti ng of "Commerci a l Computer Softwa re" a nd
"Commerci a l Computer Softwa re Documenta ti on", a s s uch terms a re defi ned i n 48 C.F.R. § 252.227-7014(a )(5)
a nd 48 C.F.R. § 252.227-7014(a )(1), a nd us ed i n 48 C.F.R. § 12.212 a nd 48 C.F.R. § 227.7202, a s a ppl i ca bl e.
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Cons i s tent wi th 48 C.F.R. § 12.212, 48 C.F.R. § 252.227-7015, 48 C.F.R. § 227.7202 through 227.7202-4, 48 C.F.R. §
52.227-14, a nd other rel eva nt s ecti ons of the Code of Federa l Regul a ti ons , a s a ppl i ca bl e, Stora geCra ft's
Softwa re a nd Documenta ti on a re l i cens ed to Uni ted Sta tes Government end us ers wi th onl y thos e ri ghts a s
gra nted to a l l other end us ers , a ccordi ng to the terms a nd condi ti ons conta i ned i n thi s Agreement.
Section 12Compliance with Export Law. The Softwa re i s s ubject to export control s by the U.S. Depa rtment of
Commerce (DOC), under the Export Admi ni s tra ti on Regul a ti ons (“EAR”) (s ee http://www.access.gpo.gov/bis/index.
html ). Vi ol a ti on of U.S. l a w i s s tri ctl y prohi bi ted. Li cens ee a grees to compl y wi th the requi rements of the EAR
a nd a l l a ppl i ca bl e i nterna ti ona l , na ti ona l , s ta te, regi ona l a nd l oca l l a ws a nd regul a ti ons , i ncl udi ng a ny
a ppl i ca bl e i mport a nd us e res tri cti ons . Stora geCra ft products a re currentl y prohi bi ted for export or re-export
to certa i n countri es s ubject to U.S. tra de s a ncti ons . Li cens ee a grees not to export, or re-export, di rectl y or
i ndi rectl y, a ny product to a ny country outl i ned i n the EAR, nor to a ny pers on or enti ty on the DOC Deni ed
Pers ons , Enti ti es a nd Unveri fi ed Li s ts , the U.S. Depa rtment of Sta te’s Deba rred Li s t, or on the U.S.
Depa rtment of Trea s ury's l i s ts of Speci a l l y Des i gna ted Na ti ona l s , Speci a l l y Des i gna ted Na rcoti cs Tra ffi ckers ,
or Speci a l l y Des i gna ted Terrori s ts . Furthermore, Li cens ee a grees not to export, or re-export, Stora geCra ft
products to a ny mi l i ta ry enti ty not a pproved under the EAR, or to a ny other pers on or enti ty for a ny mi l i ta ry
purpos e, nor wi l l Li cens ee s el l a ny Stora geCra ft product for us e i n connecti on wi th chemi ca l , bi ol ogi ca l , or
nucl ea r wea pons or mi s s i l es ca pa bl e of del i veri ng s uch wea pons .
Section 13Notices. Al l noti ces between the Pa rti es s ha l l be i n wri ti ng a nd s ha l l be deemed to ha ve been gi ven
i f pers ona l l y del i vered or s ent by certi fi ed or regi s tered ma i l (return recei pt reques ted) or el ectroni c
fa cs i mi l e to the a ddres s es s et forth a s fol l ows , a nd s ha l l be deemed effecti ve upon recei pt:
If to Stora geCra ft to:

Lega l Depa rtment
Stora geCra ft Technol ogy Corpora ti on
121 Wes t El ecti on Roa d, Sui te 110
Dra per, UT 84020

If to Li cens ee to:

To the l a s t known a ddres s tha t Li cens ee provi ded to
Stora geCra ft

Section 14Microsoft® Windows® Preinstallation Environment License (“WinPE”). Stora geCra ft i s a l i cens ee under a
l i cens e gra nted by Mi cros oft wi th res pect to Mi cros oft Wi ndows Prei ns ta l l a ti on Envi ronment s oftwa re,
i ncl udi ng vers i ons 2005 a nd 2.0. Li cens ee a ccepts the fol l owi ng terms a nd condi ti ons concerni ng Wi nPE:
14.1.The Softwa re i s l i mi ted to us e a s a boot, di a gnos ti c, di s a s ter recovery, s et up, res tora ti on, emergency
s ervi ces , i ns ta l l a ti on, tes t/or confi gura ti on uti l i ti es progra m, a nd i s not for us e a s a genera l purpos e
opera ti ng s ys tem or a s a s ubs ti tute for a ful l y functi ona l vers i on of a ny opera ti ng s ys tem products .
14.2.THE SOFTWARE CONTAINS WINPE, WHICH INCLUDES A SECURITY FEATURE THAT WILL CAUSE THE COMPUTER
SYSTEM TO REBOOT WITHOUT PRIOR NOTIFICATION TO THE LICENSEE AFTER TWENTY-FOUR (24) HOURS OF
CONTINUOUS USE. THIS TIME-OUT FEATURE WILL RESET EACH TIME THE COMPONENT CONTAINING WINPE IS
RELAUNCHED.
14.3.Any a nd a l l Mi cros oft a nd Mi cros oft a ffi l i a te’s l i a bi l i ty rel a ted to the Softwa re a re di s cl a i med i n ful l
a nd wi thout condi ti on.
14.4.Al l cus tomer s upport i s s ues wi l l be ha ndl ed s ol el y by Stora geCra ft.
14.5.Li cens ee i s s peci fi ca l l y prohi bi ted from revers e engi neeri ng, decompi l i ng, or di s a s s embl i ng Wi nPE,
except to the extent expres s l y permi tted by a ppl i ca bl e l a w.
14.6.Li cens ee i s s peci fi ca l l y i nformed tha t the Softwa re i s s ubject to U.S. export juri s di cti on.
14.7.In the event tha t Li cens ee’s brea ch of thi s Agreement pl a ces Stora geCra ft i n brea ch of i ts l i cens e
a greement wi th Mi cros oft, Li cens ee a grees to i ndemni fy a nd hol d Stora geCra ft ha rml es s from a ny s uch
brea ch, notwi ths ta ndi ng the l i mi ta ti ons on l i a bi l i ty i mpos ed el s ewhere i n thi s Agreement.
Section 15Network Configuration Utility. The Softwa re i ncl udes the Network Confi gura ti on Uti l i ty ba s ed on a
deri va ti ve crea ted by Stora geCra ft under a l i cens e gra nted by Pi erre Mouni r (The Truth), a propri eta ry
s oftwa re product copyri ghted © 2003-2004 wi th a l l ri ghts res erved.
Section 16Miscellaneous.
16.1.Activation.

The Documenta ti on des cri bes the proces s of a cti va ti ng the Softwa re, whi ch i nvol ves
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recogni ti on of ea ch s ea t of l i cens ed Softwa re by Stora geCra ft’s a cti va ti on s erver. The records of
Stora geCra ft’s a cti va ti on s erver a re determi na ti ve i n a ny ques ti on concerni ng whether a s ea t of l i cens ed
Softwa re ha s been a cti va ted by Li cens ee.
16.2.Severability. If a ny provi s i on of thi s Agreement i s unenforcea bl e or i nva l i d purs ua nt to a ny a ppl i ca bl e
l a w, s uch unenforcea bi l i ty or i nva l i di ty wi l l not render thi s Agreement unenforcea bl e or i nva l i d a s a
whol e, a nd s uch unenforcea bl e or i nva l i d provi s i on wi l l be cha nged a nd i nterpreted s o a s to bes t
a ccompl i s h the objecti ves of s uch provi s i on wi thi n the l i mi ts of a ppl i ca bl e l a w.
16.3.Entire Agreement. Unl es s Li cens ee ha s entered i nto a s epa ra te, wri tten a nd s i gned a greement wi th
Stora geCra ft or one of i ts dea l ers , di s tri butors , res el l ers , or a uthori zed repres enta ti ves for the s uppl y of
the Softwa re (i ncl udi ng wi thout l i mi ta ti on a ma na ged s ervi ce provi der a greement), thi s Agreement i s the
compl ete a nd excl us i ve s ta tement of the a greement between Stora geCra ft a nd Li cens ee concerni ng the
Softwa re a nd s upers edes a l l previ ous communi ca ti ons , repres enta ti ons , unders ta ndi ngs a nd
a greements , ei ther ora l or wri tten, between the Pa rti es .
16.4.No Waiver or Modification. Thi s Agreement ma y not be modi fi ed except by a wri tten a ddendum i s s ued by
a dul y a uthori zed repres enta ti ve of Stora geCra ft. No del a y or fa i l ure to ta ke a cti on repres ents a wa i ver of
the ri ghts i nherent to or gra nted to Stora geCra ft under thi s Agreement.
16.5.No Third Party Beneficiary. No thi rd pa rty i s or s ha l l be a benefi ci a ry of thi s Agreement a nd no thi rd pa rty
s ha l l ha ve the ri ght to enforce thi s Agreement.
16.6.Assignment. Thi s Agreement i s pers ona l to Li cens ee a nd ma y not be a s s i gned or a s s umed (i ncl udi ng by
opera ti on of l a w) wi thout Stora geCra ft’s pri or wri tten cons ent. A cha nge of control of Li cens ee s ha l l
cons ti tute a n a s s i gnment.
16.7.Compliance. For Softwa re l i cens ed for bus i nes s or commerci a l purpos es , duri ng the peri od thi s
Agreement rema i ns i n effect, a nd for three yea rs therea fter, Stora geCra ft ma y veri fy Li cens ee’s compl i a nce
wi th thi s Agreement on i ts premi s es duri ng i ts norma l bus i nes s hours a nd i n a ma nner tha t mi ni mi zes
di s rupti on to Li cens ee’s bus i nes s . Stora geCra ft ma y us e a n i ndependent a udi tor for thi s purpos e wi th
Li cens ee’s pri or a pprova l , whi ch Li cens ee wi l l not unrea s ona bl y wi thhol d.
16.8.Headings and Captions. The hea di ngs a nd ca pti ons us ed i n thi s Agreement a re for conveni ence or
reference onl y a nd s ha l l not modi fy, expa nd, l i mi t, or des cri be the s cope or i ntent of thi s Agreement or i n
a ny other wa y a ffect the terms or condi ti ons of thi s Agreement.
16.9.Force Majeure. No del a y, fa i l ure or defa ul t i n performa nce of a ny obl i ga ti on of Stora geCra ft hereunder
s ha l l cons ti tute a brea ch of the Agreement to the extent ca us ed by a force ma jeure.
16.10.Applicable Law. Thi s Agreement s ha l l be governed a nd cons trued i n a ccorda nce wi th the l a ws of the
Sta te of Uta h, U.S.A., wi thout a ppl i ca ti on of a ny choi ce-of-l a w or confl i ct-of-l a w pri nci pl es , rul es , or
provi s i on tha t woul d res ul t i n the a ppl i ca ti on of the l a ws of a ny juri s di cti on other tha n Uta h. Any a cti on
for provi s i ona l rel i ef concerni ng thi s Agreement or the Pa rti es ’ rel a ti ons hi p hereunder, i ncl udi ng but not
l i mi ted to a tempora ry res tra i ni ng order, prel i mi na ry i njuncti on, a tta chment i n a i d of a rbi tra ti on, or order
for a ny i nteri m or cons erva tory mea s ure, s ha l l be brought i n Sa l t La ke County, Sta te of Uta h, U.S.A. The
Pa rti es cons ent a nd s ubmi t to the excl us i ve juri s di cti on of the s ta te or federa l courts i n Sa l t La ke County,
Sta te of Uta h, U.S.A., for purpos es of a ny a cti on for s uch provi s i ona l remedy or i nteri m or cons erva tory
mea s ure. The Uni ted Na ti ons Conventi on on Contra cts for the Interna ti ona l Sa l e of goods does not a ppl y
to thi s Agreement.
16.11.Dispute Resolution. Any di s pute, controvers y or cl a i m a ri s i ng out of, rel a ti ng to, or i n connecti on wi th
thi s Agreement, i ncl udi ng, wi thout l i mi ta ti on, a ny di s pute rega rdi ng i ts va l i di ty or termi na ti on or the
performa nce or brea ch hereof but excl udi ng a ny cl a i m for vi ol a ti on of copyri ght, tra dema rk, or other
i ntel l ectua l property ri ghts , s ha l l be s ubmi tted for fi na l res ol uti on by a rbi tra ti on a dmi ni s tered by the
Ameri ca n Arbi tra ti on As s oci a ti on (the “AAA”). If Li cens ee i s a U.S. res i dent or ma i nta i ns a pl a ce of
bus i nes s i n the U.S., the a rbi tra ti on s ha l l be conducted i n a ccorda nce wi th the AAA Commerci a l
Arbi tra ti on Rul es i n effect a t the ti me of the a rbi tra ti on, except a s they ma y be modi fi ed by a greement of
the Pa rti es . If Li cens ee i s not a U.S. res i dent a nd/or does not ma i nta i n a pl a ce of bus i nes s i n the U.S.,
the a rbi tra ti on s ha l l be conducted i n a ccorda nce wi th the AAA Interna ti ona l Arbi tra ti on Rul es i n effect a t
the ti me of the a rbi tra ti on, except a s they ma y be modi fi ed herei n or by a greement of the Pa rti es . The
a rbi tra ti on s ha l l be conducted by two a rbi tra tors s el ected from the AAA ros ter of neutra l s , a nd the pl a ce
of a rbi tra ti on s ha l l be Sa l t La ke County, Sta te of Uta h, U.S.A., unl es s otherwi s e a greed by the Pa rti es . The
proceedi ngs s ha l l be conducted i n the Engl i s h l a ngua ge. Ea ch of the two a rbi tra tors mus t be fl uent i n the
Engl i s h l a ngua ge a nd mus t be a n a ttorney wi th experi ence i n s oftwa re l i cens i ng tra ns a cti ons . In the
event of a n a rbi tra ti on conducted under the Interna ti ona l Arbi tra ti on Rul es , the a rbi tra tors mus t a l s o
ha ve experi ence i n i nterna ti ona l bus i nes s tra ns a cti ons . Any a wa rd rendered by the a rbi tra tors s ha l l be
fi na l a nd bi ndi ng on the Pa rti es hereto a nd ma y be cha l l enged i n a court of competent juri s di cti on onl y
upon thos e grounds a l l owed under the Uta h Uni form Arbi tra ti on Act, Uta h Code Ann. s ecti on 78B-11-101 et
s eq. In the a bs ence of cha l l enge, judgment on the a wa rd ma y be entered i n a ny court of competent
juri s di cti on. Wi thout l i mi ti ng the a uthori ty conferred on the a rbi tra l tri buna l by thi s Agreement a nd the
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Rul es , s uch tri buna l s ha l l ha ve the a uthori ty to exerci s e equi ta bl e pri nci pl es a nd a wa rd equi ta bl e
remedi es . By a greei ng to Arbi tra ti on, the Pa rti es hereto do not i ntend to depri ve a ny court of competent
juri s di cti on i n Sa l t La ke County, Sta te of Uta h, U.S.A., of i ts a bi l i ty to i s s ue a ny form of provi s i ona l remedy,
i ncl udi ng but not l i mi ted to a tempora ry res tra i ni ng order, prel i mi na ry i njuncti on, a tta chment i n a i d of
a rbi tra ti on, or order for a ny i nteri m or cons erva tory mea s ure. A reques t for s uch provi s i ona l remedy or
i nteri m or cons erva tory mea s ure by a Pa rty to a court s ha l l not be deemed a wa i ver of a n a greement to
a rbi tra te.
16.12.CDDL. The Softwa re’s executa bl e, VBoxHDDXSP.dl l , i ncl udes unmodi fi ed fi l es conta i ni ng Vi rtua l Box
Open Source Edi ti on s ource code, whi ch i s l i cens ed under the Common Devel opment a nd Di s tri buti on
Li cens e Vers i on 1.0 (“CDDL”). Stora geCra ft ma de no “modi fi ca ti ons ” to the CDDL-l i cens ed fi l es a nd
Stora geCra ft i s not a “contri butor” a s defi ned i n the CDDL. Irres pecti ve of the CDDL, the Softwa re i s
l i cens ed a nd di s tri buted s ol el y i n a ccorda nce wi th the terms a nd condi ti ons of thi s Agreement a nd the
CDDL gi ves Li cens ee no ri ght, ti tl e or i nteres t i n or to the Softwa re. The CDDL a nd a l l referenced CDDLl i cens ed s ource code i s a va i l a bl e a t http://downl oa d.vi rtua l box.org/vi rtua l box/3.1.2/Vi rtua l Box-3.1.2-OSE.
ta r.bz2.
16.13.Customer Contact. If Li cens ee ha s a ny ques ti ons concerni ng thi s Li cens e, Li cens ee ma y conta ct
Stora geCra ft a s fol l ows : webs i te - www.s tora gecra ft.com; tel ephone – 801-545-4700; fa x - 801-545-4705;
ma i l – Stora geCra ft Technol ogy Corpora ti on, 121 Wes t El ecti on Roa d, Sui te 110, Dra per, Uta h 84020, U.S.A.
Version: April 2010
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